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Ch. 11. Understanding Keyboard and Typing Skills 
Technology and keyboard styles have changed, but the art of typing has remained the same. Anyone who spends 
hours, or even minutes, sitting in front of a computer can benefit from typing lessons. 

 

Symbol Explanation 

Windows PC keyboards have a Windows key represented by a flag. 

Esc Escape 

F1 - F12 Functional Keys. 

Tab Tab key 

Caps Lock Caps lock key 

Shift Shift key 

Ctrl Ctrl key 

Alt Alt key (PC Only; Mac users have Option key) 

Back Space Back space key 

Delete Delete or Del key 

Enter Enter key 

Prt Scrn Print screen key 

Scroll lock Scroll lock key 

Pause Pause key 

Break Break key 

Insert Insert key 

Home Home key 

Page up Page up or pgup key 

Page down Page down or pgdn key 

Num Lock Num Lock key 

~  Tilde 

`  Acute, Back quote, grave, grave accent, left quote, open quote, or a push 

!  Exclamation mark, Exclamation point, or Bang 

@  At or At symbol 

#  Octothorpe, Number, Pound, sharp, or Hash 

£ Pounds Sterling or Pound symbol 

€ Euro 

$  Dollar sign 

¥ Japanese Yen 

%  Percent 

^  Caret or Circumflex 
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&  Ampersand or And 

*  Asterisk and sometimes referred to as star. 

(  Open parenthesis 

)  Close parenthesis 

-  Hyphen, Minus or Dash 

_  Underscore 

+  Plus 

=  Equals 

{  Open Brace 

}  Close Brace 

[  Open bracket 

]  Close bracket 

|  Pipe, Or, or Vertical bar 

\  Backslash or Reverse Solidus 

/  Forward slash, Solidus, Virgule, or Whack 

:  Colon 

;  Semicolon 

"  Quote, Quotation mark, or Inverted commas 

'  Apostrophe or Single Quote 

< Less Than or Angle brackets 

> Greater Than or Angle brackets 

, Comma 

. Period, dot or Full Stop 

? Question Mark 

 
There is several typing software available to you to download free. They come packed with the lessons and 
practice text you can use to practice your typing. While you are typing, the program will alert you of any mistakes 
and will guide you through the steps to be a faster typist. Typing Master is a wonderful piece of software that can 
get you to type really well. 
 
Typing is a helpful skill for almost anyone to have, but it's a necessary skill for people working in administrative, 
data-entry, or office positions. Many companies have a programmed speed at which they want job candidates to 
be able to type. Whether you take a typing class or learned on your own, you will need to take a typing test to 
find your typing speed, or words per minute (WPM). Some employers will require that you take a typing test during 
the interview process.  
 

Home Row 
The home row is the group of keys on the keyboard that your fingers return to after you type something. It is a 
sort of a resting place for your fingers when they aren't typing. All the fingers on your left hand (excluding the 
thumb) will rest on keys A, S, D and F, starting with the pinky. The fingers on your right hand (excluding the 
thumb) will rest on keys J, K, L and semi-colon. From these keys, your fingers will reach above or below the home 
row keys to type the letters, numbers, or symbols that are required. 
       

Capitalizing, Indenting and Spacing 
To capitalize a letter or type a symbol or punctuation mark that appears on the top portion of a key, hold down 
the "Shift" key while you strike the key that shows the letter or symbol you want to create. When you take your 
finger off the "Shift" key, the typewriter or computer will resume typing in lower case. To type in all capital 
letters, depress the "Caps Lock" key. You'll need to press it again when you want to go back to typing in lower 
case. 
 
Paragraphs need to be indented. To indent a paragraph, press the "Tab" key on the left side of the keyboard. This 
key can be tapped again to indent further. 
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To leave a space, you must press the long horizontal bar at the bottom of the keyboard. Each tap will leave a 
space. If you hold the bar down for any length of time, spacing will be continuous and you will quickly advance 
across the page. 
 
Navigation keys are used for moving around in documents or WebPages and editing text. They include the arrow 
keys, HOME, END, PAGE UP, PAGE DOWN, DELETE, and INSERT. 
 
Numeric Keypad is handy for entering numbers quickly. The keys are grouped together in a block like a 
conventional calculator or adding machine. 
 
To move down the page and to subsequent lines, you will need to strike the "Enter" key. This key is situated on the 
right side of your typewriter. Each time you press this key, you will be brought to the next line on the page. It is 
not necessary to strike this key each time you reach the end of a line of text. Your typewriter will advance to the 
next line automatically. 
 
 

Useful Shortcuts 
The following table lists some of the most useful keyboard shortcuts. For a more detailed list, see Keyboard 
shortcuts. 
 

Windows Logo 
Key 

Open the Start menu 

ALT+TAB Switch between open programs or windows 

ALT+F4 Close the active item, or exit the active program 

CTRL+S Save the current file or document (works in most programs) 

CTRL+C Copy the selected item 

CTRL+X Cut the selected item 

CTRL+V Paste the selected item 

CTRL+Z Undo an action 

CTRL+A Select all items in a document or window 

F1 Display Help for a program or Windows 

Windows Logo +F1 Display Windows Help and Support 

ESC Cancel the current task 

Application Key Open a menu of commands related to a selection in a program. Equivalent to right-
clicking. 

 

Using the numeric keypad 
The numeric keypad arranges the numerals 0 though 9, the arithmetic operators + (addition), - (subtraction), * 
(multiplication), and / (division), and the decimal point as they would appear on a calculator or adding machine. 
These characters are duplicated elsewhere on the keyboard, of course, but the keypad arrangement allows you to 
rapidly enter numerical data or mathematical operations with one hand. To use the numeric keypad to enter 
numbers, press NUM LOCK. Most keyboards have a light that indicates whether NUM LOCK is on or off. When NUM 
LOCK is off, the numeric keypad functions as a second set of navigation keys. You can use your numeric keypad to 
perform simple calculations with Calculator. 
 

Print Screen (or Prt Scn) 
A long time ago, this key actually did what it says—it sent the current screen of text to your printer. Nowadays, 
pressing PRINT SCREEN captures an image of your entire screen (a "screen shot") and copies it to the Clipboard in 
your computer's memory. From there you can paste it (CTRL+V) into Microsoft Paint or another program and, if 
you want, print it from that program. 
 

Scroll Lock (Or Scr Lk) 
In most programs, pressing SCROLL LOCK has no effect. In a few programs, pressing SCROLL LOCK changes the 
behavior of the arrow keys and the PAGE UP and PAGE DOWN keys; pressing these keys causes the document to 
scroll without changing the position of the cursor or selection. Your keyboard might have a light indicating 
whether SCROLL LOCK is on. 
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Pause/Break 
THIS key is rarely used. In some older programs, pressing this key pauses the program or, in combination with 
CTRL, stops it from running. 
 

Tips for Using Your Keyboard Safely 
Using your keyboard properly can help avoid soreness or injury to your wrists, hands, and arms, particularly if you 
use your computer for long periods of time. Here are some tips to help you avoid problems: 
 

 Place your keyboard at elbow level. Your upper arms should be relaxed at your sides. 

 Center your keyboard in front of you. 

 Type with your hands and wrists floating above the keyboard, so that you can use your whole arm to reach 
for distant keys instead of stretching your fingers. 

 Avoid resting your palms or wrists on any type of surface while typing. If your keyboard has a palm rest, 
use it only during breaks from typing. 

 While typing, use a light touch and keep your wrists straight. 

 When you're not typing, relax your arms and hands. 

 Take short breaks from computer use every 15 to 20 minutes. 
 

Number Pad 
The number pad keys are arranged in four columns and five rows. In our first lesson we will cover the 4 5 6 - + 
row, when at rest the fingers of the typist's right hand are positioned, lightly, on the 4 5 6 - + keys. 
 

 Index Finger will control the 4 key 

 Middle Finger will control the 5 key 

 Ring Finger will control the 6 key 

 Little Finger will control the - key 

 Little Finger will control the + key 

 The 0 is controlled by the Right Thumb 
 

 Index Finger will control the 1 key 

 Middle Finger will control the 2 key 

 Ring Finger will control the 3  key 

 Ring Finger will control the . key 
 

 Index Finger will control the 7 key 

 Middle Finger will control the 8 key 

 Ring Finger will control the 9 key 

 Middle Finger will control the / key 
 

Use a Comfortable Keyboard and Mouse               
Try to keep the keyboard and mouse at a 
comfortable position so that you can keep a 
relaxed posture and not have to stretch too 
far to do your work. 
 
Monitor at Eye Level 
Keep the monitor at eye level so that you 
don’t have to bend or stretch your neck to 
look at it. Keep your monitor two feet away 
from you because of the rays older monitors 
emit.  
 
Take Frequent Breaks 
It is so important to take time out in the 
day to get up and stretch your legs and 
arms. Staring at the computer screen too 
long can also hurt your eyes. 
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Care for Your Eyes 
If you are working at the computer for long periods of time, be sure to blink your eyes frequently and try to give 
them a break by focusing on a distant object for a few seconds every 15 to 20 minutes. Computer users have dry 
eyes because they don’t blink as often as someone not using the computer all day. Have some eye drops handy 
when working on the computer for long periods of time. 
 
Use a Wrist Rest 
If you do a lot of typing and reflection on the computer, use a wrist rest for the keyboard and mouse so that you 
don’t put unnecessary strain on your wrist because of bad positioning. 
 
Invest In a Good Chair 
If you’re going to be sitting for a while, you might as well invest in a good chair. Buy a chair that has an adjustable 
back and adjustable height and that provides lower-back support. 
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Ch. 12. Microsoft Windows 
Operating System 
All Operating Systems are responsible for managing hardware, resources, and data. The responsibility of the OS 
regarding user interface (UI) consists of displaying an interface that always reacts the same way and makes it easy 
for users to perform tasks. A GUI attempts to make tasks easy and intuitive for the user. To provide a space for 
applications to run and for the user to manage his work, most OSes with a GUI use a ―desktop‖ symbol. That is, 
the desktop is a work area on which you have a computer, a place to store items, and a waste bin. All these 
elements also exist in the GUI. The look and feel of the GUI, such as the look of the windows that are used, also 
applies to the applications that run on the OS. When applications use the same look and feel as the OS, and by 
having the OS provide common routines and dialog boxes for opening and saving files, there is a consistent 
appearance for the user, which usually reduces the time required to learn new applications. 
 
Linux Since the creation of Linux, it has been a worldwide group project, with Linus Torvalds controlling what 
components go into the Linux kernel, or the core components that make up the brains of the Linux OS. Many 
individuals and groups have contributed programming code to the Linux kernel, usually as completed drivers for 
hardware. The only thing that is common to all versions of Linux is the OS kernel. Beyond the kernel, there are 
applications that are used with the kernel to give you a system that you can actually use to finish tasks.  When a 
group or company takes the Linux kernel, combines it with a UI (shell), and then bundles in a variety of 
applications, a distribution is created. There are a few major distributions of Linux, which have changed over the 
years. The current major distributions include Debian — GNU/Linux Fedora Core — Red Hat Gentoo Knoppix 
Slackware SUSE — openSUSE Ubuntu, all distributions have a command line interface, and most also include a 
variety of GUIs. Applications written to Linux standards don’t work on Windows-based systems but might work in 
the Macintosh OS X environment. Some developers write Linux applications to common standards, such as Java or 
GTK+, which both have components that can be installed on Windows systems. If you would like to test Linux, you 
can find several Live CDs that allow you to boot the distribution directly from the CD without installing any files on 
your hard drive.  
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Starting and Logging on to Windows XP 
Windows XP should automatically start after you 
turn on your computer. This lesson also explains 
what you need to do next. The default log in 
screen is the Welcome screen, as shown 
 

1. Click your account user name. If your 
account has a password, you will be 
prompted to enter it. 

 
NOTE: If someone has turned off the Welcome 
screen, logging in will be a little different, as 
shown. 

2. Enter your user name and password. If 
your account doesn’t have a password, 
leave the text box blank. 

3. Remember that when you enter your 
password, Windows will display a series of ******s to protect your password from prying eyes. 

4. Press <Enter> or click OK. Windows logs in using your account settings. 

 
Understanding the Windows XP Screen 
You might find the Windows screen a bit confusing and 
overwhelming the first time you see it. Nothing on the screen 
appears familiar to you—where do you even start? This lesson 
will help you become familiar with the main Windows screen, 
known as the desktop. Major Parts of the Windows XP Screen, to 
see what everything you’re looking at means. 
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Desktop 
This is the large background area of the Windows screen. You can customize the desktop by adding shortcuts to 
your favorite programs, documents, and printers. You can also change the appearance of the desktop to fit your 
mood and personality. 
 
Recycle Bin 
The Recycle Bin stores all the files you delete from your computer. You can use the Recycle Bin to retrieve files 
you’ve accidentally deleted. Create more disk space by emptying the Recycle Bin. 
 
Taskbar 
The Taskbar usually appears at the bottom of your screen and contains the famous Start button, which you use to 
start your programs. Whenever you open a program, document, or window, an icon for that program appears on 
the taskbar. This lets you see which programs are currently running and allows you to easily switch between them. 
 
Start Button 
The Start button lets you quickly open your programs and documents. You can also use the Start button to find 
files and change the settings for Windows. 
 
Quick Launch 
The Quick Launch bar gives you quick access to your most frequently used applications. Internet Explorer, Outlook 
Express and the Windows desktop are included in the Quick Launch bar by default.  
 

Start Menu 
In Start menu making it your single source for launching applications, finding documents, and changing computer 
settings. The new Windows XP Start menu takes a lot of getting used to—especially if you’re familiar with the Start 
menu in previous versions of Windows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mouse Dragging 
Place the pointer over an object and press and hold down the left mouse button. While you are still holding down 
the button, move the mouse to where you want to place the object and then release the mouse button. 
 

Right Clicking 
You already know that the left mouse button is the primary mouse button, used for clicking and double-clicking, 
and it’s the mouse button you will use over 95 percent of the time when you work with Windows. So what’s the 
right mouse button used for? Whenever you right click something, it brings up a shortcut menu that lists 
everything you can do to the object. 
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Whenever you’re unsure or curious about what you can do with an object, point to it and click it with the right 
mouse button. A shortcut menu will appear with a list of commands related to the object or area you right-
clicked. 
 

Exiting Windows and Turning off Your Computer 
At the end of the day when you’ve finished using your computer, you need to shut down Windows before you turn 
your computer off. Shutting down gives Windows a chance to tidy up after itself, saving information in the 
computer’s memory to the local disk, cleaning up temporary files, and verifying that you’ve saved any changes 
you made to any files you worked on. 
 

Saving and Opening Files in Different Locations 
By saving your files in related folders right away, you make them easier to find and don’t have to do as much file 
management later. This lesson will show you how to save your files in different locations. You’ll also learn how to 
save files in different file formats.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Finding a File Using the Search Companion 
It’s just as easy to search misplaced and lose a file in your computer. Luckily, Microsoft has simplified the search 
process by introducing the Search Companion to Windows XP. A cousin of the Office Assistant, the Search 
Companion helps you organize your search by asking certain questions, such as what you want to search for (i.e. 
picture or file), which drive to search in, and the file name. The Search Companion can search for files even when 
you can’t remember the exact filename or location. You can search for a file by: 
 

 The file name or any part of the file name 

 The date the file was created or modified 

 The type of file, such as a Microsoft Word document or graphic file 

 The text within the file 

 The size of the file 
 
You can set one or several of these criteria to search for a file. 
 

1. Click the Start button and select Search from the menu. The Search Results window appears with the 
Search Companion, as shown. The Search Companion will ask you different questions to help you with your 
search. 

2. Click the Pictures, music, or video option. The next screen of the Search Companion appears, asking you 
for more details about your search. 
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3. Check the Music box. Click in the All or part of the file name text box, Click Search. The Search 
Companion begins the search and displays the names and locations of all the files that have the words in 
their names. You can open any of these files by double-clicking them. 
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Boot Options 
Windows XP offers several alternate boot methods which can be used to bypass a problem or boot into a reduced 
environment so you can solve the problem. If you can't boot the system, this is the time to start considering the 
boot options. For example, if you've recently installed a new device driver that caused a serious system failure 
(you can't boot), you can use a boot option to boot without that driver (this is called the "Last Known Good 
Configuration," to be exact). 
 
Safe Mode 
Starts Windows XP using only basic files and drivers (mouse, except serial mouse devices; monitor; keyboard; mass 
storage; basic video; default system services; and no network connections) 
  
Safe Mode with Networking 
Starts Windows XP using only basic files and drivers, plus network connections 
  
Safe Mode with Command Prompt 
Starts Windows XP using only basic files and drivers, after you log on, the command prompt is displayed instead of 
the Windows desktop. 
  
Enable Boot Logging 
Starts Windows XP while logging all the drivers and services that were loaded (or not loaded) by the system to a 
file, this file, called ntbtlog.txt, is located in the %windir% directory. Safe Mode, Safe Mode with Networking, and 
Safe Mode with Command Prompt add to the boot log a list of all the drivers and services that are loaded. The 
boot log is useful in determining the exact cause of system startup problems. 
  
Enable VGA Mode 
Starts Windows XP using the basic VGA driver, this mode is useful when you have installed a new driver for your 
video card that is causing Windows XP to hang or start and lock up half-way into the initialization process. The 
basic video driver is always used when you start Windows XP in Safe mode (Safe Mode, Safe Mode with Networking, 
or Safe Mode with Command Prompt). 
  
Last Known Good Configuration 
Starts Windows XP using the Registry information that Windows saved at the last shutdown, use this option only in 
cases in which you strongly suspect a program has written incorrect or damaging information to the Registry. The 
last known good configuration does not solve problems caused by corrupted or missing drivers or files. Also, any 
changes made since the last successful startup are lost. 
  
Directory Services Restore Mode 
This option is valid only for domain controllers 
  
Debugging Mode 
Starts Windows XP while sending debug information through a serial cable to another computer 
  
Start Windows Normally 
This option boots the system without altering the normal boot operation. Use this selection to return to normal 
booting after you've made any other selection from the advanced menu. Selecting this option causes the normal 
boot to occur immediately; you will not be returned to the boot menu. 
  
Reboot 
This command reboots the system immediately, without first booting into Windows XP or even returning to the 
boot menu. 
  
Return to OS Choices Menu 
This command returns to the boot menu without making an alternate boot selection. 
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System Restore 

System Restore is a fabulous mechanism which first appeared with Windows Me. Now Windows XP incorporates it, 
too. System Restore enables you to restore the computer to a previously saved state. So, you can "roll back" your 
computer to the way it was working before your dog jumped on the keyboard, or before you installed that stupid 
program or device driver that lunched your system. Here's how it works. 
 
Performing a system restore does not affect personal files, such as documents, Internet favorites, or email. It 
simply reverses system configuration changes and removes installed files to return the system to a stored state. 
System Restore automatically monitors your system for changes. Periodically easily identifiable restoration points 
are created. Plus, you can create your own restoration points manually. 
 
It should be obvious, but I'll state it anyway: System Restore is only accessible if you can boot Windows XP. If your 
system does not boot, you must use one of the previously mentioned system recovery techniques. 
 
There are two control interfaces for System Restore. One is on the System Restore tab of the System applet. The 
other is the System Restore utility itself accessed through Start, All Programs, Accessories, System Tools, System 
Restore. 
 
Restore points are created by Windows XP automatically whenever any one of several specific events occurs: 
 

 On first boot after installation 

 Every 24 hours of calendar time or every 24 hours of computer uptime 

 When a program is installed using InstallShield or Windows Installer 

 Automatic updates via Windows Update 

 Any restore operation 

 Installation of unsigned device drivers 

 At any restore operation using Backup 
 
The creation of a restore point at any restore operation allows you to reverse a restoration. Thus, if after a 
successful restoration you are not pleased with the outcome, you can reverse the restoration. The system 
automatically removes any failed or incomplete restoration operations. 
 
System Restore does not replace the uninstallation process for removing an application. System Restore only 
monitors and protects against changes to the OS. It does not track the addition of new files to the system. Use the 
Add or Remove Programs utility or a vendor provided uninstall routine to remove applications. 
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Troubleshooting 

When I troubleshoot a problem on my own systems, I try to mentally walk backwards through whatever I've done 
to the system over the last few days or weeks. In many cases, I'll remember installing some downloaded 
application or changing some Control Panel setting that I meant to uninstall or reverse, but never got around to do 
it.  
 
If I don't discover anything obvious physically, I try a power-off reboot. The power-off reboot will reset all 
hardware devices, and in many cases resolve the problem (if it was device related). If possible, shut down the 
system gracefully. Then keep the power off for about 10 seconds before switching the system back on. You'll be 
amazed at how often this works. 
 
My next steps always include a walk through the Event Viewer and any other types of log files I can find. Let the 
problem guide you in this process. For example, if the video system is failing, you probably don't need to look 
through the modem logs. 
 
For me, every problem is unique. Often requiring a different resolution than any other problem I've tackled in the 
past. However, there are some general rules or guidelines I try to follow: 
 

 Try only one change at a time 

 Reboot twice after each change 

 Test each change for success 

 Keep a log of your changes, you may need to undo them to produce a result, or you may need the 
resolution process again in the future 

 Consult vendor Web sites for possible solutions, if the problem seems to be specific to one device or 
software component 

 Try to undo any recent changes to the system, including new hardware or software patches 

 Review areas of the system which have caused problems in the past 

 Try to repeat the failure; knowing where, how, or why the failure occurs can lead to a solution 
 
Troubleshooting is both an art and a science. You'll need organized patience and outrageous ingenuity. Plus, 
knowing where to look stuff up never hurts. Keep in mind that the entire Internet is waiting at your finger tips and 
mouse clicks. 
 
 

WordPad 

For more capable word processing than Notepad can accomplish, you can use WordPad. Though it's not Word or 
WordPerfect, it works fine for most everyday writing chores. It includes most of the formatting tools people need 
for typical writing projects, and the price is right. You can edit documents of virtually any length, it supports 
drag-and-drop editing, and it can accept graphics pasted to it from the Windows Clipboard. WordPad supports the 
following: 
 

 Standard character formatting with font, style, and size 

 Standard paragraph formatting with changing line spacing, indents and margins, bullets, justification, and 
right and left alignment 

 Adjustable tab stops 

 Search and replace 

 Headers and footers 

 Pagination control 

 Insert and edit graphics 

 Undo 

 Print preview 
 
It doesn't do tables, columns, indexes, master documents, outline view, legal line numbering, or anything really 
groovy, though. Go get Word or WordPerfect if you have that level of needs. 
 
Save and Open Options 
WordPad can save and open files in several formats: 
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 Rich Text Format This choice is the default. The Rich Text Format is used more and more as a common 
format for exchanging documents between word processors, though few, if any, use it as their primary 
format. The Rich Text Format preserves the appearance as well as the content of your document. 
Graphics and other objects can be saved in the file along with the text but might be lost when you open 
the file with another application. 

 

 Text Files See the discussion of text files earlier in the chapter in the section covering Notepad. 
 

 Unicode See the discussion of Unicode earlier in the chapter in the section covering Notepad. 
 
WordPad also can open the following document types (although it must save changes to these files as .RTF, Text, 
or Unicode documents): 
 
Word for Windows This choice opens documents stored in the format used by Microsoft Word for Windows version 
6.0, and Microsoft Word 95 (.DOC). If you have any version of Microsoft Word installed, incidentally, double-
clicking a .DOC file opens it in Word, not WordPad. 
 
WordPad correctly opens even incorrectly named (wrong extension) RTF and Word 6 files if you select the All 
Documents option in the Files of Type area in the Open dialog box or type the document's full name. If WordPad 
doesn't detect a file's format, it opens it as a text-only file. Note that if a document contains formatting 
information created by another application it will likely appear as garbage characters mixed with the document's 
normal text. 
 
 

Paint 
Paint is a simple drawing program that creates and edits bitmapped images in a variety of formats. Using free-
form drawing tools, text, and special effects, you can create projects such as invitations, maps, signs, and 
wallpaper for your desktop, and you can edit images linked into documents created by other programs. 
 
Let me explain why Paint is called a bitmapped image editor. Your computer's screen is divided into very small 
dots (pixels or pels) that are controlled by the smallest division of computer information bits. A bitmap is a 
collection of bits of information that creates an image when assigned (mapped) to dots on the screen. 
 
Being a bitmapped drawing program, rather than an object-oriented drawing program like Adobe Illustrator or 
CorelDraw, Paint has some significant limitations to keep in mind also some advantages. After you paint a shape, 
you can't move it independently. You can use the computer to remove an area of the painting and place it 
somewhere else’s if you were cutting out a piece of the canvas and pasting it elsewhere. But all the dots in the 
area get moved, not just the ones in the shape you're interested in. 
 
Windows XP Professional doesn't come with an object-oriented graphics program. Simple object-oriented graphics 
modules are included in some word processors and spreadsheets. An addition to Paint that appeared in the 
Windows 2000 version and carries over to Windows XP is the capability to save files in JPG and GIF formats in 
addition to the usual bitmapped (BMP) formats. 
 
BMP 
Bit-Mapped Picture 
BMP files store graphics in a format called DIB. They tend to be large in file size, and are used by Windows for 
features things such as screen wallpaper. 
 
JPG 
Joint Photographic 
Highly compressed means of storing graphics files, and Experts Grou often compress to about 5% of uncompressed 
size. This is a "lossy" format, meaning that some of the detail is lost as a sacrifice for small sized files. Often used 
on the Web or for storing photos from digital cameras. 
 
GIF 
Graphics Interchange Format 



Oracas Certified Computer Expert - Part 2 - Office Applications        Oracas (Pvt.) Limited 

- 16 - 

Often used on Web pages for logos or other images with limited color (256 maximum) graphics, Like JPG, GIF files 
can be stored with compression, making them very efficient in terms of storage space and email or Web 
transmission. GIF files discard color data rather than image detail. 
  
PNG 
Portable Network Graphics 
A relatively new format similar to GIF and created by the World Wide Web Consortium (W3C) as a freely usable, 
unlicensed format for storing graphics and photos. 
  
TIF 
Tagged Image File Format 
This is one of the most widely supported and cross-platform file formats for images on PCs (including Macs). These 
files are not used on the Web. Web browsers can't display them, and they are often large. Digital cameras 
sometimes store highest quality, uncompressed images in TIF format. Because TIF files use lossless compression 
(no visual data is ever lost), this format is recommended for archival storage of image data. 
 
 

Multimedia, Imaging, and Windows 
When Windows was first developed in the mid-1980s, none of the hardware we use today to capture and transform 
still and video images was available. However, as time passed, still photographers and, more recently, video 
graphs, have discovered the computer and its capability to edit, transform, organize, and store their work. 
 
Whether you're a serious photographer with a casual camera user who's looking for a way to organize company 
photos, Windows XP contains built-in tools and features that are designed to make the marriage of images and 
pixels a happy one. Even if you plan to replace the multimedia and imaging tools in Windows XP with higher-
powered third-party solutions, Windows XP's architecture makes it easier to use the tools you want to work with 
the photos and video you love to create. 
 
Some of the imaging and multimedia tools built in to Windows XP are improved versions of those originally 
designed for Windows Me, whereas others are brand new. Windows XP Professional has every one of the imaging 
and multimedia tools found in Windows XP Home Edition, so you no longer need to sacrifice imaging and 
multimedia performance for the stability and security of a corporate operating system. With Windows XP 
Professional, multimedia and imaging work as well in the office as they do at home. 
 
Windows XP works with virtually any type of imaging device you can connect to your computer, including 
 

 Scanners 

 Digital cameras 

 Web cameras 

 DV camcorders 

 
 

Display Properties 
The most obvious means for altering your GUI display settings is the Display Properties dialog box. From there, you 
can reach a multitude of GUI settings, mostly affecting visual stylings rather than GUI functionality per se: 
 

 Screen saver settings 

 Desktop background 

 Colors and fonts for GUI elements 

 Active Desktop setting 

 Color depth and resolution 

 Special GUI effects such as menu sliding 

 Energy-saving settings 
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 Device drivers 

 Advanced properties such as hardware acceleration 

 

Themes 
"A theme is a background plus a set of sounds, icons, and 
other elements to help you personalize your computer with 
one click." That just about sums it up, I think. All the 
settings you make on the other tabs of the Display 
Properties dialog box can be saved to a theme file on the 
Themes tab. Windows XP includes a few themes, such as 
the default Windows XP scheme (a.k.a. Luna) and the 
classic theme (similar to the default theme of Windows 
2000). Microsoft offers several other themes for download, 
and many third parties have created themes for Windows 
XP as well. To download additional themes from Microsoft, 
select the Mode Themes Online option from the Theme 
pull-down list, and Windows XP will take you to the online 
theme stash. 

 

Desktop 
The desktop is used to express your inner personality. 
"Hanging wallpaper" (a picture of your kids, your car, a 
sunset, a nebula, and so forth) on your desktop gives the 
environment a more personalized feeling. Microsoft 
includes dozens of options for you. These include small tiles (a.k.a. patterns) that are repeated across and down 
your screen to make a pattern as well as larger single images centered on the screen (some of which are quite 
stunningly beautiful). If the image is too small to fill up your desktop, you can always set the Position control to 
Stretch. 
 
Clicking on the Customize Desktop button at the bottom of the Desktop tab opens the Desktop Items dialog box. 
On the General tab of this dialog box, you can select from four common shortcut icons to appear on the desktop: 
My Documents, My Computer, My Network Places, and Recycle Bin. You can also manage the icons used for these 
desktop shortcuts using the Change Icon and Restore Default buttons. 
 
Another interesting feature of Windows XP's new user experience is the Desktop Cleanup Wizard. By default it is 
launched every 60 days to prompt you to remove items you've not been using. If you elect to remove items from 
the desktop, they are moved into an Unused Desktop Items folder which is added to the desktop by this wizard. 
You can disable the 60 day launch by clearing the check box (that's one of the first settings I change!). You can 
also force a desktop cleanup by clicking the Clean Desktop Now button. 
 

Screen Saver 
We all know what screen savers are. On the Screen Saver tab of the Display Properties dialog box, you can choose 
from several supplied screen savers and perhaps others that you have installed from other sources. In the old days 
when phosphors would "burn," screen savers actually did something useful. They prevented a ghost of the image 
on the screen from being burned into the screen for all time, no matter what is being displayed. Most modern 
CRTs don't actually need a screen saver to save anything because the phosphors are more durable. Also, LCD 
monitors don't need them either because they don't have any phosphors on the screen at all. 
 

Appearance 
From the Appearance tab, you can radically alter the look of your entire Windows machine. You can do some 
serious mischief here, creating some egregious color schemes that will attract the fashion. Or you can design or 
choose schemes that improve readability on screens (or eyes) with certain limitations. If, perchance, you're using 
a monochrome monitor (no color), altering the colors may still have some effect (the amount depends on how you 
installed Windows), so these settings are not just for systems with color screens. 
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In most cases your desktop is set to the Windows XP style by default, which is fine for most screens and users. If 
you prefer the styling’s of Windows 2000, you can go retro by selecting Windows Classic style from the Windows 
and buttons pull-down list. 
 

Settings Tab 
On the Settings tab of the Display Properties dialog box, you can tweak the video driver's most basic settings 
screen resolution (desktop size) and color quality (color depth). 
 
Assuming that Windows XP has properly identified your video display card and that the correct driver is installed, 
the Color Quality drop-down list box should include all the legitimate options your card is capable of. Your color 
depth options are limited by the amount of video RAM on the card and the resolution you choose. The higher the 
resolution, the more memory is used for pixel addressing, limiting the pixel depth (number of colors that can be 
displayed per pixel). With many modern cards, this limitation is no biggie, and it's likely that many Windows XP 
users will not have to worry about it except in cases when they have large monitors displaying 1600x1200 and want 
32-bit color and a high refresh rate. If you find that setting the color scheme up to high color or true color causes 
the resolution slider to move left, this is the reason. All modern analog color monitors for PCs are capable of 
displaying 16 million colors, which is dubbed true color. 
 
 

Folder Views 
Windows XP offers a wide range of options for customizing how files are displayed through the My Computer and 
Windows Explorer utilities. The View menu (see Figure 23.10) offers the following controls: 
 
Toolbars 
This control is used to display or hide the standard buttons, Address bar, and links bar. You can also lock the bars 
(so stray clicks don't alter your layout) or fully customize the button toolbar. 
 
Status bar 
This control enables the display of an information bar at the bottom of the utility which shows object details, file 
size, free space, and so on. 
 
Explorer bar 
This control sets the folder item to be displayed in the right-hand pane. No selection displays the context-sensitive 
quick access menus of File and Folder Tasks, Other Places, and Details. Selections in this control include: search, 
favorites, history, contacts, and folders. 
 
Views 
This section allows quick change of the view used to display file objects: thumbnails, tiles (default), icons, list, 
and details. 
 
Arrange Icons by 
This command is used to sort file objects by name, size, type, or modification date. There are also settings for 
show in groups, auto arrange (maximize layout starting from upper left corner), or align to grid. 
 
Choose Details 
This command sets the details that appear in ToolTips, details, and Tile view. The defaults are name, size, type, 
and modification date. Among the 33 options included are attributes, owner, subject, company, and file version. 
 
Customize this Folder 
This command is used to define custom attributes for the selected folder (see next section). 
 
Go to 
This menu is used to navigate back, forward, up one level, to the home page, or to recently visited locations. 
 
Customize This Folder 
If you have a complex organizational structure to your personal files, you might find this feature quite intriguing. 
Customizing folders allows you to select from six templates designed for a specific type of file (document, image, 
or music) or collection of files (all, one artist, one album). These templates set how the contents of these folders 
are displayed as well as the context for the menu commands.  
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Additionally, you can define a custom image for thumbnails and a unique icon for the folder. All these 
customizations can help you keep track of what you've got stored where. 
 
Setting Folder Options 
Folder Options should be seen as more of 
a superset of controls over all folders on 
a system, while folder customization is 
on an individual or parent and sub-folder 
basis. Folder Options is a Control Panel 
applet that can also be accessed from 
the Tools menu of My Computer and 
Windows Explorer. This applet is used to 
set a wide range of file system features. 
 
The General tab of the Folder Options 
dialog box defines whether common 
tasks are shown in folders or whether 
only classic Windows folders are 
displayed; whether folders are opened in 
the same or a new window; and whether 
single-clicks or double-clicks are used to 
open items. If you make changes to this 
tab, you can always return to the default 
by clicking the Restore Default button. 
 
The View tab performs two major functions folder view management and advanced settings management. For 
folder view management, all folders can be reset to their default views, or the currently selected folder's view 
can be applied to all folders. Advanced settings management contains a long checklist of settings. 
 
 

Visual Effects 
In addition to the controls we've already mentioned in the Display applet, there are additional visual effect 
controls in the System applet from the Control Panel. On the 
System applet's Advanced tab, click on the Settings button in 
the Performance area. This opens the Performance Options 
dialog box. The Visual Effects tab can be set to allow 
Windows to manage effects, set for best appearance, set for 
best performance, or set with your own custom settings. 
 
When Custom settings are selected, you can then enable or 
disable a long list of effects. These effects include animate 
resizing of windows, fade ToolTips, show shadows under 
menus, and use visual styles on windows and buttons. 
 
Unless your system is low on physical RAM, uses an old non-
AGP video card, or uses a video card with less than 8MB of 
native RAM, there is little need to modify the default settings 
for these controls in respect to performance. However, if you 
think no shadows or no animation looks better, you can 
customize the look and feel of the user environment all you 
want. 
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Control Panel 
One of the most common ways to access the Control Panel is to click Start, Control Panel. But there are several 
other ways, such as using the Control Panel link in the Other Places quick access menu or, in Windows Explorer 
folder view, clicking on the Control Panel sub-element of My Computer. If you have opted to expand the Control 
Panel in your Start menu, you can still right-click over the Control Panel name and select Open from the pop-up 
menu to open the regular Control Panel window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Accessibility Options 
Sets keyboard, mouse, sound, display, and other options for increasing ease of use by those who are visually, 
aurally, or motor impaired. 
 
Add Hardware 
Installs or troubleshoots a wide variety of hardware devices such as sound, video, CD-ROM, hard and floppy disk 
controllers, SCSI controllers, display adapters, keyboard, mouse, and ports. Installation of printers is covered in 
Chapter 6, "Printing and Faxing." 
 
Add or Remove Programs 
Adds, removes, or modifies applications or Windows XP components from Microsoft or a third-party. It supports 
remote application installation over the LAN. 
 
Administrative Tools 
Provides shortcuts to the administrative tools Component Services, Computer Management, ODBC settings, Event 
Viewer, Local Security Policy, Performance, and Services. 
 
Date and Time 
Sets the current date, time, and time zone for the computer, It can also synchronize system time with an Internet 
time server. 
 
Display 
Sets colors of various parts of Windows display elements, as well as other display-related adjustments, such as 
desktop background, screen saver, display driver, screen color depth and resolution, refresh rate, energy-saving 
modes, and color schemes or themes. 
 
Folder Options 
Sets system wide folder view options, file associations, and offline files. 
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Fonts 
Adds and deletes typefaces, and displays examples of system installed typefaces for screen display and printer 
output. 
 
Game Controllers 
Adds, removes, and configures game controller hardware, such as joysticks and gamepads. 
 
Internet Options 
Sets Internet Explorer options 
  
Keyboard 
Sets key repeat rate, cursor blink rate, language of your keyboard, keyboard type, and drivers, and includes 
keyboard troubleshooting wizards. 
 
Mouse 
Alters mouse properties such as motion speed, double-click, button orientation, cursor shapes, and other 
proprietary settings dependent on your mouse driver. 
  
Network Connections 
Manages all network connections, including LAN, dial-up WAN, and VPN. Networking components (clients, services, 
and protocols) are configured. 
  
Phone and Modem Options 
Adds, removes, and sets the properties of the modem(s) connected to your system. Using this applet, you can 
declare dialing rules (long-distance numbers, call waiting, credit card calling, and so on). You also can add and 
remove telephony drivers. 
 
Power Options 
Provides options for setting the Advanced Power Management (APM) and Advanced Configuration and Power 
Management (ACPM) functions. Using this applet, you can set timeouts for monitor, hard disk, system standby, and 
hibernation. 
  
Printers and Faxes 
Adds, modifies, removes, and manages printer and fax devices. Using this applet, you can manage the print queue 
for each printer and enable direct faxing from applications. 
 
Regional and Language Options 
Sets how Windows displays times, dates, numbers, and currency through region/country settings and language 
preferences. 
 
Scanners and Cameras 
Adds, removes, sets properties for, and troubleshoots scanners and digital cameras. 
 
Scheduled Tasks 
Sets up automatic execution of applications, utilities, disk cleanup, and so on. 
 
Security Center 
A central location for control of Windows Firewall, Automatic Updates, and anti-virus program (if you have one 
installed). 
 
Sound and Audio Devices 
Assigns sounds to system events and manages sound devices. 
 
Speech 
Sets voice options for text-to-speech translation. 
 
System 
Examines and changes your identification (workgroup name, domain name, computer name), installed devices, 
amount of RAM, type of processor, and so on. Using this applet, you can add, disable, and remove specific devices 



Oracas Certified Computer Expert - Part 2 - Office Applications        Oracas (Pvt.) Limited 

- 22 - 

using the Device Manager; set up hardware profiles; set up user profiles; optimize some parameters of system 
performance; set environment variables; and set emergency startup options. 
  
Taskbar and Start Menu 
Sets the properties for the taskbar and Start menu. 
  
Users Accounts 
Adds, deletes, or alters users. Using this applet, you can assign groups, manage passwords, and set logon mode.  
  
Windows Firewall 
Use this applet to turn on, turn off, and fine-tune the firewall that protects your computer from uninvited invasion 
from the Internet. 
 
Wireless Network Setup 
This applet makes setting up a wireless network much easier than before SP2. 
 
 

Windows Keyboard Shortcuts 
Windows keyboard shortcuts overview Use shortcut keys as an alternative to the mouse when working in Windows. 
You can open, close, and navigate the Start menu, desktop, menus, dialog boxes, and Web pages using keyboard 
shortcuts. Keyboard shortcuts may also make it easier for you to interact with your computer. Click a heading, or 
press TAB to highlight a heading, and then press ENTER.   
 
General keyboard shortcuts 

F1 Display Help 

CTRL+C Copy 

CTRL+X Cut 

CTRL+V Paste 

CTRL+Z Undo 

DELETE Delete 

SHIFT+DELETE Delete selected item permanently without placing the Recycle Bin 

CTRL while dragging an item Copy selected item 

CTRL+SHIFT while dragging an item Create shortcut to selected item 

F2 Rename selected item 

CTRL+RIGHT ARROW Move the insertion point to the beginning of the next word 

CTRL+LEFT ARROW Move the insertion point to the beginning of the previous word 

CTRL+DOWN ARROW Move the insertion point to the beginning of the next paragraph 

CTRL+UP ARROW Move the insertion point to the beginning of the previous paragraph 

CTRL+SHIFT with any of the arrow 
keys 

Highlight a block of text 

SHIFT with any of the arrow keys Select more than one item in a window or select text within a document 

CTRL+A Select all 

F3 Search for a file or folder 

ALT+ENTER View properties for the selected item 

ALT+SPACEBAR Opens the shortcut menu for the active window 

ALT+F4 Close the active item, or quit the active program 

CTRL+F4 
Close the active document in programs that allow you to have multiple 
documents open simultaneously 

ALT+TAB Switch between open items 

ALT+ESC Cycle through items in the order they were opened 

F6 Cycle through screen elements in a window or on the desktop 

F4 Display the Address bar list in My Computer or Windows Explorer 

SHIFT+F10 Display the shortcut menu for the selected item 

ALT+SPACEBAR Display the System menu for the active window 

CTRL+ESC Display the Start menu 

ALT+Underlined letter in a menu 
name 

Display the corresponding menu 

F10 Activate the menu bar in the active program 
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RIGHT ARROW Open the next menu to the right, or open a submenu 

LEFT ARROW Open the next menu to the left, or close a submenu 

F5 Refresh the active window 

BACKSPACE View the folder one level up in My Computer or Windows Explorer 

ESC Cancel the current task 

SHIFT when insert a CD into the CD-
ROM 

Prevent the CD from automatically playing 

ENTER Carry out the command for the active option or button 

SPACEBAR Select or clear the check box if the active option is a check box 

TAB Move forward through options 

SHIFT+TAB Move backward through options 

  
Dialog Box Keyboard Shortcuts 

CTRL+TAB Move forward through tabs 

CTRL+SHIFT+TAB Move backward through tabs 

Arrow keys Select a button if the active option is a group of option buttons. 

 
 Natural Keyboard Shortcuts 

Windows Logo  Key Display or hide the Start menu. 

Win+BREAK Display the System Properties dialog box. 

Win+D Show the desktop. 

Win+M Minimize all windows. 

Win+Shift+M Restores minimized windows. 

Win+E Open My Computer. 

Win+F Search for a file or folder. 

Win+CTRL+F Search for computers. 

Win+ L Lock your computer if you are connected to a network domain, or switch 
users if you are not connected to a network domain. 

Win+R Open the Run dialog box. 

Win+U Open Utility Manager. 
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Ch. 13. Microsoft Word 
When you use a computer program to create, edit, and produce text documents, you are word processing. 
Microsoft Office Word 2007 is one of the most sophisticated word-processing programs available today. With Word 
2007, it is easier than ever to efficiently create a wide range of business and personal documents, from the 
simplest letter to the most complex report. Word includes many desktop publishing features that you can use to 
enhance the appearance of documents so that they are appealing and easy to read. The program has been 
completely redesigned to make these and other powerful features more accessible. As a result, even novice users 
will be able to work productively in Word after only a brief introduction. 
 
As with all programs in the 2007 Microsoft Office release, the most common way to start Word is from the Start 
menu displayed when you click the Start button at the left end of the Microsoft Windows taskbar. If Word is the 
first program in the 2007 Office system that you have used, you are in for a surprise! The look of the program 
window has changed radically from previous versions. 
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Status Bar 
The reason it’s called the status bar is that it can show you the status of your document, lively updating the 
information as you type. 
 
 
 

Spots & Clutter in Your Text 
There’s no cause for alarm if you see spots -
or dots — amid the text you type, such as 
 
This•can•be•very•annoying.¶ 
 
What you’re seeing here, and potentially on the screen, are nonprinting characters. Word uses various symbols to 
represent things you normally wouldn’t see: spaces, tabs, the Enter key, and more. 
 
To turn these items on or off, click the Show/Hide button on the Home tab in the Paragraph group. Click 
once to show the goobers; click again to hide them. The keyboard shortcut for the Paragraph button is 
Ctrl+Shift+8. 
 
 

Starting Out with a New Document 

When you start your word processing day, Word automatically presents you with a blank sheet of paper — a blank 
document — on which you can start writing.  
 

1. Choose the New command from the Office Button 
menu. The New Document window appears, giving 
you too many options for creating a new something-
or-other. 

2. Click the Create button to choose Blank Document. 
The blank document option is reselected for you. All 
you need to-do is click the Create button, or press 
the Enter key, to make the New Document window 
go away, and you see your blank page, ready for 
typing.  

 
 

Formatting a Document 
Formatting makes your documents look professional and not 
like you’re using an abused typewriter from a smelly thrift 
store. And formatting is more than just making some text italic or bold or adding a heading to your document. In 
Word, formatting includes lines, styles, colors, textures, pictures — all sorts of fun stuff. 
 
In Word, you can format the following parts of a document: 

 Characters 

 Paragraphs 

 Tabs 

 Pages 

 Columns 

 Headers and footers 

 The entire document 
 
Word lets you manipulate each of these items in a variety of interesting and creative ways: margins, boxes, 
spacing, indents, lines, shading, page orientation, and on and on. But remember the following admonishment: 
 

Save Your Work 

The biggest mistake made by computer users is not saving their stuff. In Word, you must soon, regularly, and often 
save your documents to disk. 
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Only when a document has been saved on disk can you use it again later or retrieve it after a power outage or 
when you forgetfully quit Word without saving. 
 
After initially saving a document to disk, you merely 
need to update it. So, as you’re working, you save 
again. There’s no need to choose the filename at this 
point; the computer merely overwrites the old file on 
disk with your new, updated document. 
 
To save a document as you’re working on it, just keep 
choosing the Save command from the Office Button 
menu. It updates the document on disk with your 
most recent changes. 
 
 

Printing a document 
Make sure that the printer is on and ready to print, 
choose the Print command from the Office Button 
menu, or click the Print button when you’re using the 
Print Preview feature. 
 
The Print dialog box opens. In this busy place, 
printing and related activities happen. 
 
Click the OK button. The document comes out of your 
printer. 
 
 

Find and Replace 
Search and replace is one of the most basic and ancient word processor functions. In Word, it’s known 
as Find and Replace, and it consists of two features: The first feature involves searching up or down 
through a document for a tidbit of text, and the second adds the ability to change that tidbit of text 
and replace it with something else. 
 
On the Home tab, click the big Find button in the Editing group.If all else fails, use the keyboard 
shortcut: Ctrl+F.  
 
Word searches for the text you typed, starting from 
the insertion pointer’s location to the end of the 
document. If any text is found, it’s highlighted (or 
selected) onscreen, and the insertion pointer moves 
to that location in your document. At that point, you 
can click the Cancel button to make the Find and 
Replace dialog box go away. 
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Proofing Your Document 
Word’s built-in spell checker works the second you start typing. Like a hungry leopard, the spell checker is ready to 
pounce on its unsuspecting prey. Spelling is corrected in two ways in Word. The 
most obvious way is that an unrecognized word is underlined with a red zigzag. 
More subtly, the offending word is corrected for you automatically. 
 
Word has an internal library consisting of tens of thousands of words, all spelled 
correctly. When you type a word that doesn’t exist in the library, the word 
that’s typed is marked as suspect. It appears underlined with a red zigzag. 
 

1. Locate the misspelled word. Look for the red zigzag underline. 
2. Right-click the misspelled word. Up pops a shortcut menu and the Mini 

Toolbar. 
3. Choose from the list the word you intended to type. Click that word and 

it’s automatically inserted into your document, to replace the spurious 
word. 

 
When a word is flagged as incorrectly spelled or as a typo, you can use two 
commands, both of which are found on the pop-up menu when you right-click 
the word. The commands are Ignore All and Add to Dictionary. 
 
Ignore All: Select this command when the word is properly spelled and you don’t 
want Word to keep flagging it as misspelled. 
 
Add to Dictionary: This command adds words to the list that Word refers to so 
that the word becomes part of the internal Spelled Correctly library. 
 

Undoing an Ignore All command 
Choosing the Ignore All command means that all instances of a given misspelled word or typo are ignored in your 
document. This holds true even when you save that document and open it again later. So, if you make a mistake 
and would rather have the ignored word regarded once more, do this: 

1. Click the Word Options button on the Office Button menu. The Word Options window appears. 
2. Choose Proofing on the left side of the window. 
3. Scroll down the right side of the window (if necessary) until you can see the Recheck Document button; 

click that button. A warning dialog box appears, reminding you of what you’re about to do. 
4. Click the Yes button. Everything you’ve told Word to ignore while proofing your document is now ignored. 

It’s the ignore-ignore command! 
5. Click the OK button to return to your document. 

 
Un-adding words to the dictionary 
When you choose the Add to Dictionary command, the given word is placed into something called the Custom 
dictionary. Recognizing that people may change their minds, Word allows you to edit the Custom dictionary, to 
remove words you may have added accidentally. To remove unwanted words from the Custom dictionary, follow 
these steps: 

1. Click the Word Options button in the Office Button menu. The Word Options window shows up. 
2. From the left side of the window, choose Proofing. 
3. Click the button labeled Custom Dictionaries. The Custom Dictionaries dialog box appears. 
4. Select the CUSTOM.DIC dictionary file. It’s probably the only item in the list. 
5. Click the button labeled Edit Word List. You see a scrolling list of words you’ve added to the Custom 

dictionary. 
6. Find and select the word you want to remove from the dictionary. The word is selected by clicking it once. 
7. Click the Delete button. 
8. Repeat Steps 6 and 7 to, optionally, remove more words. 
9. Click the OK button when you’re done editing the dictionary. Close any other open windows. 
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AutoCorrect 
Some of your typos and spelling errors will never be graced with the red zigzag. That’s because Word quickly fixes 
hundreds of common typos and spelling errors on the fly. It’s done by the AutoCorrect feature, and you really have 
to be quick to see it. 
 
There’s nothing to using AutoCorrect; it happens automatically. In Word, try to type the word mispell. You cannot! 
Word uses AutoCorrect, and suddenly you see misspell. 
 
Most of the commonly misspelled words can be found in AutoCorrect’s repertoire: beleive, suposed, recieve, and so 
on. Try a few. See whether you can baffle Word! 
 
In addition to fixing spelling errors, AutoCorrect helps you enter special characters. For example, type (C) and 
AutoCorrect properly inserts the © Copyright symbol. 
 

Adding AutoCorrect 

You can add your own commonly misspelled words to its list. 
1. Right-click the misspelled word. Normally, you choose the proper spelling from the list. 
2. Click the AutoCorrect item. Up pops a submenu containing various corrections. 
3. Choose the properly spelled word from the AutoCorrect submenu. The word is added to the AutoCorrect 

list, and, as a special favor, Word corrects the word in your text as well. 
 

Proofing Your Entire Document 
Before the days of on-the-fly spell checking, you proofed your document by entering a special spell-check mode. In 
spell-check mode, the computer would read your document, from top to bottom, and alert you to any silly words it 
found. You can still use this type of proofing, which some folks find easier to handle and less disruptive than 
automatic spell checking. 
 

1. Click the Review tab. 
2. In the Proofing group, click the Spelling & Grammar 

button. The Spelling and Grammar dialog box appears, 
it displays a chunk of your document at a time, with 
each chunk containing a spelling or grammar error. 

 
Here’s what you can do: 

 To fix the error, edit the text in the box. 

 Use the Ignore button(s) to skip the error, or click the 
Next Sentence button to keep moving through the 
document. 

 Choose a proper spelling from the list and then click the Change button. 
 

Thesaurus 
When two words share the same meaning, they’re said to be synonyms; for 
example, big and large. Synonyms are helpful in that they allow you to find 
better, more descriptive words and especially to avoid using the same tired 
old words over and over. Obviously, knowing synonyms is a handy thing for 
any writer. When you don’t know a lot of them, you can use a handy, nay, 
practical tool called a thesaurus to help you. 
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Formatting 
The most basic thing you can format in a document is text — the letters, numbers, and characters you type. Just as 
your body is composed of millions of cells, documents are composed of thousands of characters. You can format 
characters to be bold, underlined, italicized, little, or big or in different fonts or colors — all sorts of pretty and 
distracting attributes. Word gives you a magnificent amount of control over the appearance of your text. This 
chapter contains the details. 
 
You can change the format of your text in two ways: 

 Choose a text-formatting command first, and then type the text. All the 
text you type is formatted as chosen. 

 Type the text first, and then select the text as a block and apply the 
formatting. This technique works best when you’re busy with a thought 
and need to return and format the text later. 

 
Clear formats    Ctrl+Spacebar 
Bold     Ctrl+B 
Double underline   Ctrl+Shift+D 
Hidden text    Ctrl+Shift+H 
Italic     Ctrl+I 
SMALL CAPS    Ctrl+Shift+K 
Continuous underline *   Ctrl+U 
Word underline *   Ctrl+Shift+W 
Subscript    Ctrl+= 
Superscript    Ctrl+Shift+= 
Makes text size larger   Ctrl+] 
Makes text size smaller   Ctrl+[ 
 

Formatting in the Font Dialog Box 
There’s a place in Word where all your font-formatting delights are 
kept in a neatly organized fashion. It’s the Font dialog box. The Font 
dialog box contains all the commands for formatting text, even quite a 
few that didn’t find their way into the Font group.  
 

Changing the CASE of Text 
Believe it or not, upper- and lowercase do have something to do with a 
font. Back in the old mechanical-type days, fonts came in a case, like 
a briefcase. The top part of the case, the upper case, held the capital 
letters. The bottom part of the case held the lowercase letters. So, in 
a way, changing the case of text is kind of a font-formatting trick. 
 
To change the case of text in Word, use the Change Case command 
button in the Font group. Choosing that button displays a menu of 

options. Select the text you want to change, and 
then choose the proper item from the Change 
Case command button. Your text is modified to 
match the menu item that’s selected. 
 
 
You can also use the Shift+F3 command to change the case of selected text. But that keyboard 
shortcut cycles between only three of the menu options ALL CAPS, lowercase, and Capitalize 
Each Word. 
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Formatting Paragraphs 
Word provides ample tools for formatting paragraphs of text. There’s a simple way, for example, to automatically 
indent the first line of a paragraph. Imagine! That and other amazing formatting tricks, all designed to impress and 
inspire, are found in this handy chapter. 
 
Center     Ctrl+E 
Fully justify    Ctrl+J 
Left-align   Ctrl+L 
Right-align   Ctrl+R 
Indent     Ctrl+M 
Unindent    Ctrl+Shift+M 
Hanging indent    Ctrl+T 
Unhanging indent   Ctrl+Shift+T 
Single-space lines   Ctrl+1 
1.15 line spacing   Ctrl+0 
Double-space lines   Ctrl+2 
11⁄2-space lines   Ctrl+5 
 

Ruler 
The Paragraph dialog box can be an intimidating place, what with all the numbers and terminology and such. A 
more graphical, and therefore more fun, way to control a paragraph’s indentation and margins is to use the Ruler. 
The Ruler may be hidden in your copy of Word. To show it, click the View Ruler button, found atop the vertical 
(right) scroll bar. The Ruler appears on the top of the writing part of the Word window. In Print Layout view, a 
vertical ruler also shows up and runs down the left side of the window. 
 
The dark gray part of the Ruler (outside ends) is beyond 
the margins that are set for the page. The lighter gray is 
inside the page margins and the Ruler measures that 
space from the left, starting with zero inches. 
 

Tabs 
Tabs are really part of paragraph formatting, but the 
topic frustrates so many Word users that I decided to dedicate this entire chapter to the subject of setting tabs.  
 
Pressing the Tab key inserts a tab character into your 
document. That tab character works like a wide space 
character, but its size is determined by the tab stop. The 
tab stop is a predefined location marked across a page — 
say, every half-inch — although in Word you can set tab 
stops at any interval. 
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Page Margin 
Every page has margins. They provide the air around your document — that 
inch or so of breathing space that sets off the text from the rest of the page. 
As with other things in Word, these margins can be adjusted, fooled, cajoled, 
or otherwise obsessed with. 
 
To change the margins, use the Page Setup group on the Page Layout tab. By 
clicking the Margins button in that group displays a menu full of common 
margin options. Specific margins can be set by clicking the Custom Margins 
button at the bottom of the Margins menu. Doing so displays the Margins tab 
in the Page Setup dialog box, where specific margin information can be 
entered, including information on printing more than one page on a sheet of 
paper. 
 

Page Numbering 
Word not only can automatically number your pages, but it also lets you 
place the page number just about anywhere on the page and in a variety of 
fun and interesting formats. 
 

 In the Insert tab’s Header & Footer area, click the Page Number 
command button. A menu drops down, listing various page-numbering 
options. The first three are locations: Top of Page, Bottom of Page, 
and Page Margins or the sides of the page. 

 Choose where to place the page numbers. I want my page numbers 
on the bottom of the page, so I regularly choose the Bottom of Page 
option. 

 Pluck a page-numbering style from the scrolling list. There are oodles of samples, so don’t cut yourself 
short by not scrolling through the menu. You can even choose those famous page X of Y formats. 

 

Starting afresh on a new, blank page 
To start typing on a new page in your document, you need to insert a manual page break, also called a hard page 
break. The simplest way to do this is to press the Ctrl+Enter key combination. Word then begins a new page On 
That Very Spot. All text before the insertion pointer is on the previous page, and all text afterward is on a new 
page.  
 
You can also insert a hard page break by choosing the Page Break command from the Pages group 
on the Insert tab. 
 

Watermark 
When finer papers are held up to the light, they show a watermark, an image embedded into the paper. The image 
is impressive but faint. Word lets you fake a watermark by inserting faint text or graphics behind every page in 
your document. 

 Click the Page Layout tab. 

 In the Page Background group, click the Watermark button. A menu plops down with a host of predefined 
watermarks that you can safely duck behind the text on your document’s pages. 

 Choose a watermark from the long, long list. The watermark is applied to every page in your document. 
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Headers and Footers 
Documents can have headers and headings, footers and footnotes. It’s easy to confuse things — until you read these 
handy bullets and peruse this section. A header is text that appears at the top of every page. It’s contained in a 
special, roped-off part of the page where you can place special text. Footer is text that appears at the bottom of 
every page. Like the header, it has its own special area and contains special text. Headers and footers contain 
elements such as your name, the document name, date, page number, title, and phone numbers. 
 
You can use a header. You can use footer. You can use them both. You can use neither. Either way, the technique 
is the same: 
 

1. Click the Insert tab. 
2. From the Header & Footer group, choose the Header button. A list of preformatted headers is displayed. 
3. Choose the format you want from the list. The header is added to your document, saved as part of the 

page format. If you were in Draft view, you’re immediately switched to Print Layout view so that you can 
edit the header. 

4. Type the required replacement text. For example, replace [Enter Document Title] with the real title of 
your document. 

5. When you’re done, click the Close Header and Footer command button in the Close group on the far right 
side of the Ribbon. 

 

Applying a document theme 
Choosing a theme is done from the Page Layout tab, in the Themes group. Built-in 
themes are listed on the Themes button’s menu along with any custom themes 
you’ve created yourself. 
 

 Each of the built-in themes controls all three of the major theme elements, 
changing your document’s contents accordingly. 

 Pointing the mouse at a theme previews your document, by showing how it 
would look if you went ahead and applied that theme. 

 Click to select a theme. 

 Because a document can use only one theme at a time, choosing a new 
theme replaces the current theme. 

 To remove a theme from your document, choose the Office theme or the 
menu command Reset to Theme from Template. 

 If you would rather change only one part of a theme, such as a document’s 
fonts, use the Theme Colors, Theme Fonts, or Theme Effects command 
button in the Themes group. 
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The Border 
Quick application of a border is possible, thanks to the Border command button, 
found in the Home tab’s Paragraph group. Clicking that button immediately applies a 
border to your text, or removes the borders, as is the case with the No Border 
button shown in the margin. 
 
When you click the menu part of the Border command button, a menu full of border 
choices is made available. Choosing a border from the menu not only applies that 
border to your text, but also changes the Border command button to reflect that 
new border style. 
 
You can use only one border style from the Border menu at a time. Choosing another 
style replaces the first style. If you want some combination of borders, you must use 
the Borders and Shading dialog box, as described in the next section. That dialog box 
also allows you to change the line style, color, and thickness of your border. 
 

Borders and Shading 
For real control over borders, you call the Borders and Shading dialog box. Choosing 
the Borders and Shading command from the bottom of the Border menu does the 
job. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tables 
You can build a table from scratch, or you can convert text that’s already in your document into a table. My advice 
is to start from scratch: Create the table first and then fill it with information. Word allows you to add or remove 
rows or columns, so there’s no need to be precise when you first start out. 
 
Use the Quick Tables submenu from the Table menu to select a pre-designed table 
and slap it down into your document. Unless the table you need is on that submenu, 
though, you’re better off manually creating a table. 
 

Drawing a Table 
Especially when your table may not be a pure grid or need even columns and text, 
you can use a special drawing mode to splash down a unique table in your 
document. 
 

1. From the Table menu, choose Draw Table. The insertion pointer changes to 
a pencil. 

2. Drag the mouse to ―draw‖ the table’s outline in your document. 
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The key to deleting all or part of a table is to first position the insertion pointer in the part of the table 
you want to remove. Then choose the table element to remove from the Delete button’s menu. 
 

The Distribute Rows and Distribute Columns command buttons help clean up uneven 
column or row spacing in a table. With the insertion pointer anywhere in the table, click 
either or both buttons to even things out. 

 

Bullets and Numbers 
There are many ways to punctuate a list. You can try hanging indents, make the first few words bold, or take 
advantage of Word’s list-enhancing features, as covered in this section. 
 

 Bullets and numbers are handled in the Home tab’s Paragraph group. 

 The Multilevel List command is best applied when you have a list that’s indented. Pressing the Tab key to 
indent a line uses the next level’s format. 

 
To apply bullets to your text, highlight the paragraphs you want to shoot and choose the Bullets command 
button, from either the Home tab’s Paragraph group or the Mini Toolbar. Instantly, your text is not only 
formatted with bullets but is also indented and made all tidy. 
 
To number a list, select the paragraphs with the mouse and click the Numbering command button. Each 
paragraph is numbered starting with 1 and continuing through however many paragraphs are in the list. 
The paragraphs are also formatted so that the number appears as a hanging indent. 
 

Wrapping text around the Image 
I use the terms in-line, wrapped, and floating to describe how Word places text into a 
document. Word uses seven different terms to control how graphics and text mix. But 
as long as you think in-line, wrapped, and floating, you’ll keep your sanity. 
 

 In Line With Text: The image is treated like text — specifically, like a large, 
single character. The image can have text before it or behind it, be in the 
middle of a paragraph of text, or be on a line by itself. But the image stays 
with the text as you edit, and the line that the image is on grows extra vertical 
space to put up the image. 

 Square: The image sits on the same plane as the text, but the text flows around 
the image in a square pattern, regardless of the image’s shape. 

 Tight: Text flows around the image and hugs its shape. 

 Behind Text: The image floats behind the text, looking almost like the image is 
part of the paper. 

 In Front of Text: The image floats on top of your text, like a photograph 
dropped on the paper.  

 Top and Bottom: Text stops at the top of the image and continues below the image. 

 Through: Text flows around the image as best it can, similar to the Tight option. 

 Edit Wrap Points: This command allows you to specifically control how text wraps around an image. By 
adjusting tiny handles and dashed red lines, you can really make text wrapping as tight or creative as you 
like.  Of course, selecting the Tight option pretty much does the same thing. 

 More Layout Options: This option summons the Advanced Layout dialog box, which provides custom controls 
for image position as well as wrapping options. 

 

WordArt 
I probably don’t need to write a lot about WordArt because too many Word users find it fun and 
enjoyable. WordArt’s command button is in the Text group, on the Insert tab. Here’s how you 
work it. Click the WordArt button to display the WordArt menu. 

 
Text Box 

A text box can be used as a decorative element to highlight a passage of text on the page, or it can be 
just an information box or an to the side. Overall, the purpose of the text box is to prevent your 
document from becoming what layout artists refer to as the dreaded Great Wall of Text.  
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Ch. 14. Microsoft Excel 
Microsoft Excel is most excellent spreadsheet and data analysis software for the personal computer. While Word 
lets you create and edit documents, Excel specializes in letting you create, edit, and analyze data that’s organized 
into lists or tables. This grid-like arrangement of information is called a spreadsheet. In Excel 2007, Microsoft 
introduces its brand-new Ribbon user interface to everybody’s favorite spreadsheet program. This new interface is 
so called because of its reliance on a new on-screen element called the Ribbon as the means by which the vast 
majority of Excel commands are selected. 
 
Some common spreadsheets include: 

 Business documents like financial statements, invoices, expense reports, and earnings statements. 

 Personal documents like weekly budgets, catalogs, exercise logs, and shopping lists. 

 Scientific data like experimental observations, models, and medical charts. 
 
Excel really shines in its ability to help you analyze a spreadsheet’s data. For example, once you’ve entered a list 
of household expenses, you can start crunching numbers with Excel’s slick formula tools. Before long you’ll have 
totals, subtotals, monthly averages, a complete breakdown of cost by category, and maybe even some predictions 
for the future. 
 
Excel is not just a math wizard. If you want to add a little life to your data, you can inject color, apply exotic 
fonts, and even create macros (automated sequences of steps) to help speed up repetitive formatting or editing 
chores. And you can use Excel’s many chart-making tools to build everything from 3-D pie charts to more exotic 
scatter graphs. 
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The Ribbon radically changes the way you work in Excel 2007. You 
no longer need to memorize which pull-down menu or toolbar 
contains the command you want to use. The designers and 
engineers at Microsoft came up with the Ribbon, which always 
shows you all the most commonly used options needed to perform 
a particular Excel task. 
 
The Ribbon is made up of the following components: 

 Tabs: Excel’s main tasks are brought together and display 
all the commands commonly needed to perform that core 
task. 

 Groups: Organize related command buttons into subtasks 
normally performed as part of the tab’s larger core task. 

 Command buttons: Within each group that you select to 
perform a particular action or to open a gallery from 
which you can click a particular thumbnail, you find 
command buttons. 

 Dialog Box launcher: This button is located in the lower-
right corner of certain groups and opens a dialog box 
containing a bunch of additional options you can select. 

 
 
 
 
 
 
 
 
 
 
 

Keeping tabs on the Excel Ribbon 
The first time you launch Excel 2007, its Ribbon contains the following seven tabs, proceeding from left to right: 

 Home: Use this tab when creating, formatting, and editing a spreadsheet. This tab is arranged into the 
Clipboard, Font, Alignment, Number, Styles, Cells, and Editing groups. 

 Insert: Use this when adding particular elements (including graphics, PivotTables, charts, hyperlinks, and 
headers and footers) to a spreadsheet. This tab is arranged into the Tables, Illustrations, Charts, Links, and 
Text groups. 

 Page Layout: Use this tab when preparing a spreadsheet for printing or reordering graphics on the sheet. 
This tab is arranged into the Themes, Page Setup, Scale to Fit, Sheet Options, and Arrange groups. 

 Formulas: Use this tab when adding formulas and functions to a spreadsheet or checking a worksheet for 
formula errors. This tab is arranged into the Function Library, Defined Names, Formula Auditing, and 
Calculation groups. Note that this tab also contains a Solutions group when you activate certain add-in 
programs, such as Conditional Sum and Euro Currency Tools. 

 Data: Use this tab when importing, querying, outlining, and subtotaling the data placed into a worksheet’s 
data list. This tab is arranged into the Get External Data, Connections, Sort & Filter, Data Tools, and 
Outline groups. Note that this tab also contains an Analysis group if you activate add-ins, such as the 
Analysis Toolpak and Solver Add-In — see Book I, Chapter 3 for more on Excel add-ins. 

 Review: Use this tab when proofing, protecting, and marking up a spreadsheet for review by others. This 
tab is arranged into the Proofing, Comments, and Changes groups (see Color Plate 6). Note that this tab 
also contains an Ink group with a sole Start Inking button if you’re running Office 2007 on a Tablet PC. 

 View: Use this tab when changing the display of the Worksheet area and the data it contains. This ta is 
arranged into the Workbook Views, Show/Hide, Zoom, Window, and Macros groups. 



Oracas Certified Computer Expert - Part 2 - Office Applications        Oracas (Pvt.) Limited 

- 38 - 

Keystroke Shortcuts 
Excel offers a wide variety of keystrokes for moving the cell cursor to a new cell. When you use one of these 
keystrokes, the program automatically scrolls a new part of the worksheet into view, if this is required to move the 
cell pointer. 
 
→or Tab    Cell to the immediate right 
←or Shift+Tab    Cell to the immediate left 
↑     Cell up one row 
↓     Cell down one row 
Home     Cell in Column A of the current row 
Ctrl+Home    First cell (A1) of the worksheet 
Ctrl+End or End, Home Cell in the worksheet at the intersection of the last column that has any data in it 

and the last row that has any data in it (that is, the last cell of the so-called active 
area of the worksheet). 

PgUp     Cell one screenful up in the same column 
PgDn     Cell one screenful down in the same column 
Ctrl+→or End, →  First occupied cell to the right in the same row that is either preceded or followed 

by a blank cell. If no cell is occupied, the pointer goes to the cell at the very end 
of the row. 

Ctrl+←or End, ←  First occupied cell to the left in the same row that is either preceded or followed 
by a blank cell. If no cell is occupied, the pointer goes to the cell at the very 
beginning of the row. 

Ctrl+↑ or End, ↑  First occupied cell above in the same column that is either preceded or followed by 
a blank cell. If no cell is occupied, the pointer goes to the cell at the very top of 
the column. 

Ctrl+↓ or End, ↓  First occupied cell below in the same column that is either preceded or followed by 
a blank cell. If no cell is occupied, the pointer goes to the cell at the very bottom 
of the column. 

Ctrl+Page Down   Last occupied cell in the next worksheet of that workbook. 
Ctrl+Page Up   Last occupied cell in the previous worksheet of that workbook. 
 

Surfing the sheets in a workbook 
Each new workbook you open in Excel 2007 contains three blank worksheets, each with its own 16,384 columns and 
1,048,576 rows (giving you a truly staggering total of 
51,539,607,552 blank cells!). But that’s not all, if ever you 
need more worksheets in your workbook, you can add them 
simply by clicking the Insert Worksheet button that 
appears to the immediate right of the last sheet tab. 
 
On the left side of the bottom of the Worksheet area, the 
Sheet tab scroll buttons appear followed by the actual tabs 
for the worksheets in your workbook and the Insert 
Worksheet button. To activate a worksheet for editing, you select it by clicking its sheet tab. Excel lets you know 
what sheet is active by displaying the sheet name on its tab in boldface type and making its tab appear to be on 
top of the others. 
 
Don’t forget the Ctrl+Page Down and Ctrl+Page Up shortcut keys for selecting the next and previous sheets, 
respectively, in your workbook. 
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Taking a tour of the Status bar 
The Status bar is the last component at the very bottom of the Excel window. The Status bar contains the following 
areas: 

 Mode: This button indicates the current state of the Excel program (Ready, Edit, and so on) as well as any 
special keys that are engaged (Caps Lock, Num Lock, and Scroll Lock). 

 Macro Recording: This button (the red dot on a tiny worksheet) opens the Record Macro dialog box where 
you can set the parameters for a new macro and begin recording it. 

 AutoCalculate: An indicator that displays the Average and Sum of all the numerical entries in the current 
cell selection along with the Count of every cell in the selection. 

 Layout: A selector that enables you to select between three layouts for the Worksheet area: Normal, the 
default view that shows only the worksheet cells with the column and row headings; Page Layout View, 
which adds rulers and page margins, and shows page breaks for the worksheet; and Page Break Preview, 
which enables you to adjust the paging of a report. 

 Zoom: A slider that enables you to zoom in and out on the cells in the Worksheet area by dragging the 
slider to the right or left, respectively. 

 
 
 
 
 
 
 

 

Creating a Basic Worksheet 
When you first launch Excel, it starts you off with a new, blank worksheet. A worksheet is the grid of cells where 
you type your information and formulas. This grid takes up most of the Excel window. It’s where you’ll perform all 
your work, such as entering data, writing formulas, and reviewing the results. Here are a few basics about Excel’s 
grid: 
 

 The grid divides your worksheet into rows and columns. Columns are identified with letters (A, B, C…), 
while rows are identified with numbers (1, 2, 3…). 

 The smallest unit in your worksheet is the cell. Cells are identified by column and row. For example, C6 is 
the address of a cell in column C 
(the third column) and row 6 (the 
sixth row). Incidentally, an Excel 
cell can hold up to 32,000 
characters. 

 A worksheet can span an eye-
popping 16,000 columns and 1 
million rows. 

 When you enter information, 
enter it one cell at a time. 
However, you don’t have to 
follow any set order. For 
example, you can start by typing 
information into cell A40 without 
worrying about filling any data in 
the cells that appear in the 
earlier rows. 

 

Excel Options 
The Excel Options window provides a central hub where you can adjust how Excel looks, behaves, and calculates. 
To get to this window, choose File-Options. 
 
The various sections in the Excel Options window let you tweak a wide variety of different details. Some of these 
details are truly handy, like the options for opening and saving files. 
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While you’re getting to know Excel, you can comfortably 
ignore most of what’s in the Excel Options window. 
 

Saving Your Spreadsheet with a Password 
Occasionally, you might want to add confidential 
information to a spreadsheet. If your computer is on a 
network, the solution may be as simple as storing your file 
in the correct, protected location. But if you’re afraid that 
you might inadvertently email the spreadsheet to the 
wrong people, or if you’re about to expose systematic 
accounting irregularities in your company’s year-end 
statements, you’ll be happy to know that Excel provides a 
tighter degree of security. It allows you to password-
protect your spreadsheets, which mean anyone who wants 
to open them has to know the password you’ve set. 
 

 You can prevent others from opening your spreadsheet unless they know the correct password. 

 You can let others read a spreadsheet, but you can prevent them from modifying it unless they know the 
correct password. 

 
1. Choose File-Save As. 
2. Click the Tools button, and then, from the pop-up menu, choose General Options. 
3. Type a password next to the security level you want to turn on. Then click OK. 

 

Adding Different Types of Data  
A typical worksheet contains both text and numbers. There isn’t a lot you can do in Excel with ordinary text (other 
than alphabetize a list, perform a simple spell check, and apply some basic formatting). On the other hand, Excel 
gives you a wide range of options for numeric data. For example, you can string your numbers together into 
complex calculations and formulas, or you can graph them on a chart. 
 

 Ordinary text. This data type includes column headings, descriptions, and any content that Excel can’t 
identify as one of the other data types. 

 Numbers. This data type includes currency values, 
integers, fractions, percentages, and every other type 
of numeric data. Numbers are the basic ingredient of 
most Excel worksheets. 

 Dates and times. This data type includes dates (like 
Oct 3, 2010), times (like 4:30 p.m.), and combined 
date and time information (like Oct 3, 2010, 4:30 
p.m.). You can enter date and time information in a variety of formats. 

 True or false values. This data type can contain one of two things: TRUE or FALSE. 
 

Regional Settings 
Windows has regional settings for your computer, which affect the way 
Microsoft programs understand things like dates and currency. You can 
change the settings, and they don’t have to correspond to where you live—
you can set them for your company headquarters on another continent, for 
instance. But keep in mind that these affect all the programs on your 
computer.  
 
If you want to fine-tune the settings in your region, click the ―Additional 
settings‖ button (in Windows 7), the ―Customize this format‖ button (in 
Windows Vista), or the Customize button (in Windows XP). Although the 
name has changed over the years, it’s still the same button. 
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AutoFill 
AutoFill is a quirky yet useful feature that lets you create a whole column or row of values based on just one or two 
cells that Excel can extrapolate into a series. Put another way, AutoFill looks at the cells you’ve already filled in a 
column or row, and then makes a reasonable guess about the additional cells you’ll want to add. People commonly 
use AutoFill for sequential numbers, months, or days. 
 

Hiding Worksheets 
When you hide a worksheet, its tab disappears, but the worksheet itself remains part of your spreadsheet file, 
available whenever you choose to unhide it. Hidden worksheets also don’t 
appear on printouts. To hide a worksheet, right-click the worksheet tab, and 
then choose Hide. (Or, for a more long-winded approach, choose Home-Cells-
Format-Hide & Unhide-Hide Sheet.) 
 
To redisplay a hidden worksheet, right-click any worksheet tab, and then choose 
Unhide. The Unhide dialog box appears along with a list of all hidden sheets. 
Select a sheet from the list, and then click OK to unhide it. (Once again, the 
ribbon can get you the same window—just point yourself to Home-Cells-Format-Hide & Unhide-Unhide Sheet.) 
 

Naming and Rearranging Worksheets 
The standard names Excel assigns to new worksheets—Sheet1, Sheet2, Sheet3, and so on—aren’t very helpful for 
identifying what they contain. And they become even less helpful if you start adding new worksheets, since the 
new sheet numbers don’t necessarily indicate the position of the sheets, just the order in which you created them. 
 
For example, if you’re on Sheet 3 and you add a new worksheet (by choosing Home-Cells-Insert-Insert Sheet), then 
the worksheet tabs read: Sheet1, Sheet2, Sheet4, Sheet3. (That’s because the Insert Sheet command inserts the 
new sheet just before your current sheet.) Excel doesn’t expect you to stick with these auto-generated names. 
Instead, you can rename them by right-clicking the worksheet tab and selecting Rename, or just double-click the 
sheet name. Either way, Excel highlights the worksheet tab, and you can type a new name directly onto the tab. 
 

Formatting Cell 
The basic principle behind cell value formatting is this: the cell value that an Excel store doesn’t necessarily match 
the cell value it displays. This gives you the best of both worlds. Your cells can store super-accurate values, but 
you don’t need to clutter your worksheet with numbers that have 13 decimal places. To make your worksheet’s as 
clear and readable as possible; you need to make sure that the display value is in a form that makes sense for your 
spreadsheet. 
 
The first time you type a number or date into a blank cell, Excel makes an educated guess about the number 
format you want. For example, if you type in a currency value like $34.99, Excel assumes you want a number 
format that uses the dollar sign. If you then type in a new number in the same cell without a dollar sign (say, 
18.75), Excel adds the dollar sign automatically (making it $18.75). 
 

Changing the Cell Value Format 
Before long, you’ll need to change a cell value format, or you’ll want to fine-tune it. The basic process unfolds like 
this:  
 

1. Select the cells you want to format. You can apply 
formatting to individual cells or a collection of cells. 
Usually, you’ll want to format an entire column at 
once because all the values in a column typically 
contain the same type of data. Remember, to select 
a column, you simply need to click the column 
header (the gray box at the top with the column 
letter) or press Ctrl+Space. 

2. Select Home-Cells-Format-Format Cells, or just right-
click the selection, and then choose Format Cells. 
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3. Set the format options. The Number tab’s options let you choose how Excel translates the cell value into a 
display value. For example, you can change the number of decimal places that Excel uses to show the 
number. (The next section covers number formatting choices in much more detail.) 

 
Most of the Format Cells dialog box’s other tabs are for cell appearance formatting, which is covered later in this 
chapter. 
 

Formatting Dates and Times 
Excel gives you lots of options here. You can use 
everything from compact styles like 3/13/10 to 
longer formats that include the day of the week, like 
Saturday, March 13, 2010. Time formats give you a 
similar range of options, including the ability to use a 
12-hour or 24-hour clock, show seconds, show 
fractional seconds, and include the date information. 
 
To format dates and times, first open the Format 
Cells dialog box shown in Figure, (Home-Cells-
Format-Format Cells). Choose Date or Time from the 
column on the left, and then choose the format from 
the list on the right. Date and Time both provide a 
slew of options. 
 

Building Basic Formulas 
Excel provides a number of different ways to build 
formulas, letting you craft them by hand or point-
and-click them into existence. In this chapter, you’ll 
learn about all of these techniques. You’ll start by 
examining the basic ingredients that make up any 
formula, and then take a close look at the rules Excel 
uses when evaluating a formula. 
 
A formula is a series of instructions that you place in a cell in order to perform some kind of calculation. These 
instructions may be as simple as telling Excel to sum up a column of numbers, or they may incorporate advanced 
statistical functions to spot trends and make predictions. But in all cases, all formulas share the same basic 
characteristics: 
 

 You enter each formula into a single cell. 

 Excel calculates the result of a formula every time you open a spreadsheet or change the data a formula 
uses. 

 Formula results are usually numbers, although you can create formulas that have text or Boolean (true or 
false) results. 

 To view any formula (for example, to gain some insight into how Excel produced a displayed result), you 
must move to the cell containing the formula, and then look in the formula bar. The formula bar also 
doubles as a handy tool for editing your formulas. 

 Formulas can evaluate a combination of numbers you input (useful when you want to use Excel as a handy 
calculator) or, more powerfully, the contents of other cells. Formulas can even process an entire group of 
cells when using certain functions. 

 
One of the simplest formulas you can create is this one:  =1+1 
 
The equal sign is how you tell Excel that you’re entering a formula. The formula that follows is what you want 
Excel to calculate. Note that the formula doesn’t include the result. 
 
All formulas use some combination of the following ingredients: 

 The equal sign (=). Every formula must begin with the equal sign. It signals to Excel that the cell contains a 
formula, not just ordinary text. 
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 The simple operators. These ingredients include everything you fondly remember from high-school math 
class, including addition (+), subtraction (−), multiplication (*), division (/), and exponentiation (^). lists 
these ingredients, also known as arithmetic operators. 

 Numbers. These ingredients are known as constants or literal values, because they never change (unless 
you edit the formula). 

 Cell references. These references point to another cell, or a range of cells, that you need data from in 
order to perform a calculation. 

 Functions. Functions are specialized formulas built into Excel that let you perform a wide range of 
calculations. For example, Excel provides dedicated functions that calculate sums and averages, standard 
deviations, yields, cosines and tangents, and much more. 

 Spaces. Excel ignores these. However, you can use them to make a formula easier to read. For example, 
you can write the formula =3*5 + 6*2 instead of =3*5+6*2. (The only exception to this rule applies to cell 
ranges, where spaces have a special meaning. 

 
If you build a legitimate formula, Excel either computes the answer or displays it in the current cell in the 
worksheet or, if unable to successfully calculate the answer, the program displays one of the following error values 
in the cell: 
 

 #NULL! appears when your formula specifies an intersection of two ranges that do not, in fact, intersect 

 #DIV/0! appears when your formula attempts to divide by zero 

 #VALUE! appears when your formula contains some sort of improper argument type or operand (such as a 
text entry when the operator requires a value) 

 #REF! appears when your formula contains an improper cell reference 

 #NAME? appears when your formula contains a text reference that Excel doesn’t recognize (such as a 
reference to a range name that no longer exists in the workbook) 

 #NUM! appears when your formula contains invalid numeric values (such as a text entry where a number is 
required) 

 #N/A appears when your formula refers to a value that is not available to it 
 

Type Character Operation Example 

Arithmetic  

+ (plus sign)  Addition  =A2+B3 

– (minus sign)  Subtraction or negation  =A3–A2 or –C4 

* (asterisk)  Multiplication  =A2*B3 

/  Division  =B3/A2 

%  Percent (dividing by 100)  =B3% 

^  Exponentiation  =A2^3 

Comparison  

=  Equal to  =A2=B3 

>  Greater than  =B3>A2 

<  Less than  =A2<B3 

>=  Greater than or equal to =B3>=A2 

<=  Less than or equal to  =A2<=B3 

<>  Not equal to  =A2<>B3 

Text  & 
Concatenates (connects) entries to produce one continuous 
entry 

=A2&‖ ―&B3 

Reference : (colon) Range operator that includes =SUM(C4:D17) 

 , (comma) 
Union operator that combines multiple references into one 
reference 

=SUM(A2,C4:D17,B3) 

 (space) 
Intersection operator that produces one reference to cells 
in common with two references 

=SUM(C3:C6 C3:E6) 

 
For example, consider the following formula: 
=5 + 2 * 2 ^ 3 – 1  =20 
 
To control this order, you can add parentheses. For example, notice how adding parentheses affects the result in 
the following formulas: 
5 + 2 * 2 ^ (3 - 1) = 13 
(5 + 2) * 2 ^ 3 – 1 = 55 
(5 + 2) * 2 ^ (3 - 1) = 28 
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5 + (2 * (2 ^ 3)) -  = 20 
 
You must always use parentheses in pairs (one open parenthesis for every closing parenthesis). If you don’t, then 
Excel gets confused and lets you know you need to fix things. 
 

Cell References 
Excel’s formulas are handy when you want to perform a quick calculation. But if you want to take full advantage of 
Excel’s power, then you’re going to want to use formulas to perform calculations on the information that’s already 
in your worksheet. To do that you need to use Cell References, Excel’s way of pointing to one or more cells in a 
worksheet. 
 
If you use cell references, you can enter all this information into different cells, and then write a formula that 
calculates a grand total. This approach buys you unlimited flexibility because you can change the cell data 
whenever you want and Excel automatically refreshes the formula results. 
 
Cell references work within formulas just as regular numbers do. For example, the following formula calculates the 
sum of two cells, A1 and A2:  =A1+A2 

 
External Reference Links 
External references in a formula are those that refer to cells outside of the current worksheet, either on other 
sheets of the same workbook file or in sheets in other workbook files. Because their cells reside outside of the 
current worksheet, it isn’t sufficient to specify the cell reference only, as you do with purely local cell references. 
When you refer to a cell that resides in another worksheet of the same workbook, you preface the cell address with 
the sheet name separated by an exclamation point (!), following this syntax: 
 
Sheet1!A1 
 
When you refer to a cell that resides in a sheet in another workbook file, you need to include the filename 
(enclosed in square brackets) as well as the sheet name (enclosed in a pair of single quotation marks) and cell 
reference, following this syntax: 
 
‘[file.xls]Sheet1’!A1 
 
Many times, you use external references to create links to values in another sheet that need to be brought forward 
to the new worksheet. When you set up a link rather than just pasting in a static value, any changes made to the 
value in the original cell are automatically updated in the linked cell. 
 

Functions 
A good deal of Excel’s popularity is due to the collection of functions it provides. Functions are built-in, specialized 
algorithms that you can incorporate into your own formulas to perform powerful calculations. Functions work like 
miniature computer programs—you supply the data, and the function performs a calculation and gives you the 
result. In some cases, functions just simplify calculations that you could probably perform on your own. For 
example, most people know how to calculate the average of several values, but when you’re feeling a bit lazy, 
Excel’s built-in AVERAGE() function automatically gives you the average of any cell range. Even more usefully, 
Excel functions perform feats that you probably wouldn’t have a hope of coding on your own, including complex 
mathematical and statistical calculations that predict trends—hidden relationships in your data that you can use to 
make guesses or predict the future. 
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In many cases, you don’t want to refer to just a single cell, but rather a range of cells. A range is simply a grouping 
of multiple cells. These cells may be next to each other (say, a range that includes all the cells in a single column), 
or they could be scattered across your worksheet. Ranges are useful for computing averages, totals, and many 
other calculations. To group together a series of cells, use one of the three following reference operators: 
 

 The comma (,) separates more than one cell. For example, the series A1, B7, H9 is a cell range that 
contains three cells. The comma’s known as the union operator. You can add spaces before or after a 
comma, but Excel just ignores or removes them (depending on its mood). 

 The colon (:) separates the top-left and bottom-right corners of a block of cells. You’re telling Excel: ―Hey, 
use this block of cells in my formula.‖ For example, A1:A5 is a range that includes cells A1, A2, A3, A4, and 
A5. The range A2:B3 is a grid that contains cells A2, A3, B2, and B3. The colon is the range operator—by far 
the most powerful way to select multiple cells. 

 The space can find cells that are common to two or more different cell ranges. For example, the 
expression A1:A3 A1:B10 is a range that consists of only three cells: A1, A2, and A3 (because those three 
cells are the only ones found in both ranges). The space is technically the intersection operator, and it’s 
not used terribly often. 

 
 You can’t enter ranges directly into formulas that just use the simple operators. For example, the formula 
=A1:B1+5 doesn’t work, because Excel doesn’t know what to do with the range A1:B1. (Should it sum up the range? 
Or average it? Excel has no way of knowing.) Instead, you need to use ranges with functions that know how to use 
them. For instance, one of Excel’s most basic functions is named SUM(); it calculates the total for a group of cells. 
To use the SUM() function, you enter its name, an open parenthesis, the cell range you want to add up, and then a 
closing parenthesis. Here’s how you can use the SUM() function to add together three cells, A1, A2, and A3:  
 
=SUM(A1,A2,A3) 
=SUM(A1:A3) 
=AVERAGE(number1, number2) 
= COUNT(D4:D8) 
 

Logical Operators 
So far, you’ve seen the basic arithmetic operators (which are used for addition, subtraction, division, and so on) 
and the cell reference operators (used to specify one or more cells). There’s one final category of operators that’s 
useful when creating formulas: logical operators. 
 
Logical operators let you build conditions into your formulas so the formulas produce different values depending on 
the value of the data they encounter. You can use a condition with cell references or literal values. For example, 
the condition A2=A4 is true if cell A2 contains the same value as cell A4. On the other hand, if these cells contain 
different values (say 2 and 3), then the formula generates a false value. Using conditions is a stepping-stone to 
using conditional logic. Conditional logic lets you perform different calculations based on different scenarios.  
 
For example, you can use conditional logic to see how large an order is, and provide a discount if the total order 
cost’s over $5,000. Excel evaluates the condition, meaning it determines if the condition’s true or false. You can 
then tell Excel what to do, based on that evaluation. 
 
= Equal to   1=2  FALSE 
> Greater than   1>2  FALSE 
< Less than   1<2  TRUE 
>= Greater than or equal to 1>=1  TRUE 
<= Less than or equal to  1<=1  TRUE 
<> Not equal to   1<>1  FALSE 
 
The granddaddy of all the Logical functions is the IF function, which follows this syntax: 
 
IF(logical_test,value_if_true,value_if_false) 
=IF(B4>C4,True,False) 
=IF(B4>=1000,200,0) 
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Ch. 15. Microsoft PowerPoint 
Microsoft Office PowerPoint 2007 is full featured presentation program that helps you quickly and efficiently 
develop dynamic, professional-looking presentations and then deliver them to an audience. You can use 
PowerPoint to: 
 

 Introduce an idea, proposal, organization, product, or process with professionally designed high-impact 
slides. 

 Use galleries of styles and formatting options to achieve the right combination of colors, fonts, and effects. 

 Bolster your arguments by easily adding pictures, shapes, and fancy display text. 

 Convey numeric data in easy-to-grasp ways with styled tables or visually compelling charts. 

 Use Smart Art graphics to create sophisticated diagrams that reflect processes, hierarchies, and other 
relationships. 

 Create custom layouts so that your presentation has a unique look and feel. 

 Collaborate with colleagues, giving and receiving feedback to ensure the best possible presentation. 
 
PowerPoint 2010 has been extensively overhauled and improved with this version. You'll notice some obvious 
changes as soon as you start the program, because the top of the program window has a completely new look, 
"Exploring PowerPoint 2010." But the improvements go way beyond these changes in appearance. 
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Creating a Presentation 
When you first start PowerPoint, a blank presentation is displayed in the presentation window, ready for you to 
enter text and design elements. If you want to create a presentation from scratch, this is the place to start. 
 
However, creating presentations from scratch is time-consuming and requires quite a bit of skill and knowledge 
about PowerPoint. Even people with intermediate and advanced PowerPoint skills can save time by capitalizing on 
the work someone else has already done. In the New Presentation window, you can preview and download 
presentations that are available from Office Online and then customize these templates to meet your needs. You 
can also use any presentation that you have already created and saved on your hard disk as the basis for the new 
presentation. 
 
When you create a new presentation based on a template, you are not opening the template; instead you are 
creating a new file that has all the characteristics of the template. The new file is temporary until you save it. 
 

1. Click the Microsoft Office Button, and then click New. 
2. In the left pane of the New Presentation window, under Microsoft Office Online, click Design slides. The 

center pane now displays categories of ready-made designs. 
3. In the center pane, click each category in turn, scroll through the thumbnails of the various design 

collections, and click the Back button at the top of the center pane to return to the list of categories. 
4. In the center pane, click the Business category. 
5. Scroll about a third of the way down the list of templates, and click the Trust design template. Then in the 

lower-right corner of the window, click Download, and if the Microsoft Office Genuine Advantage message 
box appears, click Continue. 

 
A new presentation with a single title slide opens on your screen in Normal view. The Slides tab shows a thumbnail 
of the slide, and the slide itself appears in the Slide pane. 
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6. On the Home tab, in the Slides group, click the New Slide button (not its arrow). PowerPoint adds Slide 2 to 
the presentation with the default Title And Content layout. This layout is designed to accommodate a title 
and either text or graphic content table, chart, diagram, picture, clip art image, or movie clip. 

7. In the Slides group, click the New Slide arrow, and then in the list, click Two Content. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. In the Slides group, click the New Slide button. PowerPoint adds another slide with the Two Content 
layout. For all but the title slide, simply clicking the New Slide button adds a slide with the layout of the 
active slide.  

9. Continue adding slides, selecting a different layout each time so that you can see what each one looks like. 
10. At the top of the Overview pane, on the Slides tab, click Slide 2. Then in the Slides group, click the Delete 

button. PowerPoint removes the slide from the presentation and renumbers all the subsequent slides. 
CLOSE the presentation without saving your changes. 

 

Rearranging Slides in a Presentation 
After you have created several slides, whether by adding them and entering text or by importing them from 
another presentation, you might want to rearrange the order of the slides so that they effectively communicate 
your message. You can rearrange a presentation in two ways: 
 

 On the Slides tab, you can drag slides up and down to change their order. 

 To see more of the presentation at the same time, you can switch to Slide Sorter view. You can then drag 
slide thumbnails into the correct order. 

 
1. On the Outline tab, move to Slide 3, and notice the order of the bullet points. This summary slide lists all 

the main players in the series on the left, and the main plot requirements on the right. 
2. On the Outline tab of the Overview pane, scroll through the presentation, noticing that the slide order is 

different than that of the bullet points on Slide 3. 
3. In the Overview pane, click the Slides tab, and then scroll so that you can see both Slide 5 and Slide 8. 
4. Drag the thumbnail for Slide 8 (The Teacher) upward to the space above the thumbnail for Slide 6 (The 

Problem), but don't release the mouse button yet. The thumbnail itself remains in place, but a bar 
indicates where the slide will move to when you release the mouse button. 

5. Release the mouse button. PowerPoint moves the slide to its new location and renumbers the slides. 
6. At the right end of the status bar, on the View toolbar, click the Slide Sorter button. 
7. On the slider at the right end of the status bar, click the Zoom In button twice to change the Zoom 

percentage to 80%. 
8. Drag Slide 9 (The Adversary) to the left of Slide 7 (The Problem). Slide 9 moves to its new location, and 

again PowerPoint repositions and renumbers the subsequent slides in the presentation. 
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Applying a Theme 
When you create a presentation based on a template or a ready-made design, the presentation includes a theme a 
combination of colors, fonts, formatting, graphics, and other elements that gives the presentation a coherent look. 
Even a presentation developed from scratch has a theme, albeit one that consists of only a white background and a 
very basic set of font styles and sizes. 
 
If you want to change the theme applied to a presentation, you can choose a new one from the Themes group on 
the Design tab. With the live preview feature, you can easily try different effects until you find the one you want. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Inserting and Formatting a Table 
When you want to present a lot of data in an organized and easy-to-read format, a table is often your best choice. 
On a slide that includes a content placeholder, you can click the placeholder's Insert Table button to start the 
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process of creating a table. You can also click the Table button in the Tables Group on the Insert tab to add a table 
to any slide. 
 
After you specify the number of columns and rows you want in the table, PowerPoint creates the table structure, 
which consists of a two-dimensional organization of rows and columns. The box at the intersection of each row and 
column is called a cell. Often the first row is used for column headings, and the leftmost column is used for row 
headings. 
 

Inserting and Formatting a Chart 
For those occasions when you want to display numeric data visually, you can add a chart to a slide to make it easy 
to see trends that might not be obvious from looking at the numbers themselves. When you create a chart in 
PowerPoint, you use an Excel worksheet to enter the information you want to plot. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Inserting and Formatting a Diagram 
When you want to illustrate a process or the relationship between hierarchical elements, you can create a 
dynamic, visually appealing diagram by using Smart Art Graphics, a powerful new tool that comes with PowerPoint, 
Word, and Excel. By using predefined sets of formatting, you can almost effortlessly put together any of the 
following: 
 

 Process diagrams. Visually describe the ordered set of steps required to complete a task for example, the 
approval process for the launch of a new book series. 

 Hierarchy diagrams. Illustrate the structure of an organization or entity for example, a company's top-level 
management structure. 

 Cycle diagrams. Represent a circular sequence of steps, tasks, or events; or the relationship of a set of 
steps, tasks, or events to a central, core element for example, how the elements of a story all come 
together to provide an exciting ending. 

 Relationship diagrams. Show convergent, divergent, overlapping, merging, or containing elements for 
example, how organizing your e-mail, calendar, and contacts can converge to improve your productivity. 

 
On a slide that includes a content placeholder, you can click the placeholder's Insert Smart Art Graphic button to 
start the process of creating a diagram. You can also click the Smart Art button in the Illustrations Group on the 
Insert tab to add a diagram to any slide. In either case, you then select the type of diagram you want to create and 
click a specific layout to see an example and description. When you find the diagram that best conveys your 
information, you click OK to insert the diagram with placeholder text that you can replace in an adjacent text 
pane. 
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Enhancing Slides with Graphics 
With the ready availability of professionally designed templates, presentations have become more visually 
sophisticated and appealing. For better or worse, the importance of your message and the persuasiveness of the 
words you use are no longer enough to guarantee the success of a presentation. Many types of presentations can 
benefit from the addition of graphic elements as visual reinforcement or merely for decoration. 
 
The general term graphics applies to several kinds of visual enhancements. For the purposes of this chapter's 
discussion, graphics include clip art, illustrations, photographs, shapes, and fancy text. All these types of graphics 
are inserted as objects on a slide and can then be sized, moved, copied, and formatted in a variety of ways. 
 
Microsoft Office PowerPoint 2007 includes hundreds of professionally designed pieces of clip art license-free 
graphics that often take the form of cartoons, sketches, or symbolic images, but can also include photographs, 
videos, and audio clips. In a PowerPoint presentation, you can use clip art to illustrate a point you are making, as 
interesting bullet characters, or to mark pauses in a presentation. For example, you might display a question mark 
image on a slide to signal a time in which you answer questions from the audience. 
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To add clip art to a slide, you can click the Insert Clip Art button in the content placeholder, or click the Clip Art 
button in the Illustrations group on the Insert tab. either way, the Clip Art task pane opens. From this task pane, 
you can locate and insert the clip art image you want. You can search for clip art by keyword, search a specific 
Microsoft Clip Organizer collection, or search for specific files or media types, such as movies. 
 
Selecting a clip art image on a slide displays the Format contextual tab. You can use the buttons on this tab to 
modify the selected image. For instance: 
 

 You can change the color brightness and contrast of the image by using the commands in the Picture Tools 
group. 

 You can change the border, angle, and aspect of the image, apply effects such as a shadow, a glow, or a 
fuzzy border, and change the color and style of the border around the image by using the commands in the 
Picture Styles group. 

 You can size graphics to specific dimensions and crop the image by using the commands in the Size group. 

 The file size of a presentation that contains graphics can become quite large. You can shrink the size of a 
graphic file (without affecting the displayed graphic) by using the Compress Pictures button. And if you 
decide you don't like all the changes you have made to an image, you can restore the original settings by 
using the Reset Picture button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Adding Animation, Sound, and Movies  
The difference between an adequate presentation and a great presentation often lies in the judicious use of 
multimedia. By incorporating animation, sound, and movie clips, you can grab and keep the attention of your 
audience. You can emphasize key points, control the focus of the discussion, and entertain in ways that will make 
your message memorable. 
 
With Microsoft Office PowerPoint 2010, you have so many opportunities to add pizzazz to your slides that it is easy 
to end up with a presentation that looks more like an amateur experiment than a professional slide show. When 
you first start adding multimedia to your slides, it is best to err on the conservative side, especially where 
animation is concerned. As you gain more experience, you will learn how to mix and match effects to get the 
results you want for a particular audience. 
 
To apply one of three common animation effects (Wipe, Fade, or Fly In) to text or an object on a slide, you click 
the element you want to animate and then select the effect from the animate list in the Animations group on the 
Animations tab. In the case of bullet points, you can specify whether they should be animated as a set or one by 
one. To help you decide which effect to use, you can point to each in turn to see a live preview. 
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If you would rather create your own animation scheme, you can select the text or object you want to animate and 
click the Custom Animation button in the Animations group to display the Custom Animation task pane. In this task 
pane, you can quickly apply the following types of effects: 
 

 Entrance. You can animate the way that the element appears on the slide. 

 Emphasis. You can increase or decrease the importance of the element by changing its font, size, or style; 
by making it grow or shrink; or by making it spin. 

 Exit. You can animate the way that the element leaves the slide. 
 
Motion Path. You can move the element around on the slide in various ways, such as diagonally to the upper-right 
corner or in a circular motion. 
 
If none of the lists of predefined effects meets your needs, you can click More Effects at the bottom of each list to 
display galleries of professionally designed animations in four categories: Basic, Subtle, Moderate, and Exciting. 
You can see a live preview of each animation by pointing to it. 
 
After you apply an animation effect, you can fine-tune its action. For example: 
 

 You can specify whether the animation should be accompanied by a sound. 

 You can dim or hide the element after the animation, or you can have it change to a specific color. 

 If the animation is applied to text, you can animate all the text at once or animate it word by word or 
letter by letter. 

 You can set the exact timing of the animation. 

 If a slide has more than one level of bullet points, you can animate different levels separately. 

 If an object has text, you can animate the object and the text together (the default) or separately, or you 
can animate one but not the other. 

 You can specify the order of appearance of text or objects. 
 

Transition Effects 
As you work your way through the slides in an electronic presentation, you can avoid the abrupt break between one 
slide and the next by employing transitions that control the way successive slides move into view. Transitions 
include such effects as sliding in, dissolving in from the outer edges or the center, and opening like a vertical blind. 
 
Each slide can have only one transition. You set transitions in Normal view or Slide Sorter view, for one slide at a 
time, for a group of slides, or for an entire presentation. In addition to selecting the type of transition, you can 
specify the following: 
 

 The sound 

 The speed 

 When the transition occurs 
 
In this exercise, you will apply a transition to a single slide, apply the same transition to all the slides in the 
presentation, add sound to the transition, and then set the transition speed. 
 

Inserting Sounds 
A PowerPoint presentation is usually created to convey a lot of information in a short time. That information can 
be in the form of text, graphics, charts, and tables, but it might also consist of audio content. In the previous 
topic, you added sound to a slide transition. You can also insert the following types of sounds: 
 

 Audio files. You can insert an audio file for example, a speech or interview by clicking the Sound button in 
the Media Clips group on the Insert tab, and then selecting the file. 

 Sound clips. The sound clips that ship with PowerPoint include applause and a phone ring. You insert a 
sound clip by clicking the Sound arrow in the Media Clips group on the Insert tab, and then clicking Sound 
from Clip Organizer to display the Clip Art task pane, where you can select the sound you want. If you are 
connected to the Internet, clicking the Clip Art On Office Online link in the task pane takes you to the 
Microsoft Office Online Clip Art and Media Web site, from which you can download hundreds of clip art 
images, photos, sounds, and movies. 
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While inserting a sound, you can specify whether it should play automatically when the slide containing it appears 
or only when you click its icon. The sound object appears on the slide represented by an icon indicating the type of 
sound. You can change the appearance and size of the icon and move it to meet your needs. 
 
When the sound object is selected, PowerPoint adds Format and Options contextual tabs to the Ribbon. You can 
format the icon representing the sound in much the same way that you would format a picture. You can adjust its 
size and position, as well as its volume, specifies whether it is displayed on the slide, and how the sound is 
activated. 
 
To play a sound, you must have a sound card and speakers installed. In Normal view, you can test the sound 
associated with a particular slide by double-clicking the sound icon, or by selecting the icon and clicking the 
Preview button in the Play group on the Options contextual tab. In Slide Show view, the sound plays either 
automatically or when you click its icon, depending on your specifications. 
 

Inserting Movies 
Sometimes the best way to ensure that your audience understands your message is to show a movie, also known as 
a video. For example, if your company has developed a short advertising video, it makes more sense to include the 
video in a presentation about marketing plans than to try and describe it with bullet points or even still pictures. 
You can insert the following types of movies in slides: 
 

 Video clips. You can insert a digital video that has been saved as a file in one of two ways: If a slide's 
layout includes a content placeholder, you can click the Insert Movie button in the placeholder. You can 
also click the Movie button in the Media Clips group on the Insert tab. either way, the Insert Movie dialog 
box opens so that you can select the file. Before PowerPoint inserts the file, you specify whether the video 
should play automatically when the slide containing it appears or whether it should play only when you 
click it. 

 Animated clips. PowerPoint comes with several animated clips, also known as animated GIFs. (GIF stands 
for Graphics Interchange Format.) You insert these animated objects by clicking the Movie arrow in the 
Media Clips group on the Insert tab, and then clicking Movie from Clip Organizer to display the Clip Art task 
pane, where you can select the clip you want. If you are connected to the Internet, clicking the Clip Art on 
Office Online link in the task pane takes you to the Microsoft Office Online Clip Art and Media Web site, 
from which you can download hundreds of clip art images, photos, sounds, and animated clips. 

 
Both videos and animated clips appear on the slide as objects represented by icons that you can size and move to 
meet your needs. When you select an animated clip object, PowerPoint adds a Format contextual tab to the 
Ribbon so that you can adjust the way it looks on the slide. When you select a movie object, PowerPoint also adds 
an Options contextual tab so that you can adjust the object's size and position, its volume, how it is displayed on 
the slide, and how it is activated. 
 
In Normal view, you can preview a video by double-clicking its icon or by clicking the Preview button in the Play 
group on the Options contextual tab. You can preview the action of an animated clip by clicking the arrow that 
appears when you select it in the Clip Art task pane and then clicking Preview/Properties. In Slide Show view, a 
video plays either automatically or when you click its icon, depending on your specifications, whereas an animated 
clip always plays automatically. 



Oracas Certified Computer Expert - Part 2 - Office Applications        Oracas (Pvt.) Limited 

- 55 - 

 

Ch. 16. Microsoft Outlook 
Microsoft Office Outlook 2010 offers an ideal solution of integrates e-mail, address books, calendars, task lists, 
note pads, and more into one place, and more importantly, makes this information immediately available to you 
when you need it. From one window, you can work with e-mail messages, find contact information, view upcoming 
appointments, and track tasks. From one place, you can quickly search your messages (and message attachments) 
and organize your work more easily and in a more intuitive way. You can use Outlook to: 
 

 Send, receive, organize, and archive e-mail messages. 

 Send documents, spreadsheets, graphics, and other files as message attachments, and preview 
attachments you receive from other people. 

 Schedule events, appointments, and meetings, invite attendees, and reserve conference rooms, projectors, 
and other managed resources. 

 View upcoming appointments and tasks, and receive reminders for them. 

 Store contact information in a transferable format that easily interacts with your e-mail system. 

 Track tasks for yourself or for someone else, and schedule time to complete your tasks. 

 Store random bits of information as notes. 

 Share schedule information with other people, inside and outside your organization. 

 Track the interactions you have with other people. 

 Organize and easily locate information in messages, attachments, calendars, contacts, and tasks. 

 Filter out annoying junk mail. 

 Have information from favorite Web sites delivered directly to you. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Outlook 2007 supports the following types of e-mail accounts: 
 

 Exchange Server. If your organization runs Microsoft Exchange Server, you can send mail within or outside 
of your organization's network. Messages are usually stored on the e-mail server, but you can alternatively 
store them elsewhere (for example, on your computer or on a network share). By default, Outlook creates 
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a local copy of your mailbox on your computer and synchronizes with the server when you're connected, so 
you can easily work offline if necessary. 

 Post Office Protocol 3 (POP3). When connected to a POP3 account, Outlook downloads (copies) messages 
from your e-mail server to your computer. You can choose to remove the messages from the server or to 
leave them there for a specified amount of time. If you access your e-mail account from multiple 
computers, you will probably want to leave messages on the server to ensure that they're available to you. 

 Internet Message Access Protocol (IMAP). When connected to an IMAP account, Outlook stores copies of 
messages on your computer, but leaves the originals on the e-mail server. You read and manage messages 
locally, and Outlook synchronizes with the server when connected. 

 Hypertext Transfer Protocol (HTTP). Messages sent through an HTTP account (such as a Hotmail account), 
are in the form of Web pages that Outlook copies from your HTTP mail server and displays within the 
message window. 

 
You can add multiple POP3, IMAP, and HTTP accounts (but only one Exchange Server account) to your Outlook 
profile. 
 

Connecting to E-Mail Account 
The automatic setup functionality provided by the Outlook 2010 Startup wizard is a significant improvement over 
previous versions of Outlook, which required that you provide much more information. It might not work under all 
circumstances, but it generally does a very good job. In most cases, the only information you need is your e-mail 
address and password. 
 

1. Start Outlook 2010, if Outlook hasn't yet been configured to connect to an e-mail account, the Outlook 
2010 Startup wizard starts. On the welcome page, click Next 

2. If you have an e-mail account set up in another e-mail program on this computer, Outlook offers the option 
of importing account information from that account. 

3. On the Auto Account Setup page, enter your name, e-mail address, and password in the corresponding text 
boxes. Notice the option here to manually configure your server settings. If you have trouble configuring 
Outlook by using the automatic setup tool, you can make manual changes by selecting this check box and 
then clicking Next. 
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If this is the first time you have started a 2010 Microsoft Office system program, Office prompts you to enter your 
full name and initials. The programs in the 2010 Office system use this information when tracking changes, 
responding to messages, and so on. Next, Office prompts you to select the type of information you want to share 
over the Internet, and finally, offers the option of signing up for automatic program updates from the Microsoft 
Update service. None of these options place you at risk, and all can be quite useful. 
 

Connecting to Additional E-Mail Accounts 
You can add e-mail accounts to your primary Outlook profile. For example, if you want to check your work and 
personal e-mail accounts from the same Outlook profile or if you monitor another e-mail alias, such as a support 
alias. Your profile may include only one Exchange Server account, but it may contain multiple HTTP, IMAP, and 
POP3 accounts. 
 
If your profile includes multiple e-mail accounts, you can select the account you want to use each time you send an 
e-mail message. In the message header, click the Account button, and then in the list, click the account from 
which you want to send the message. The Account button is visible only when multiple accounts are configured 
within a profile. 
 
On the Tools menu, click Account Settings, The Account Settings dialog box opens, on the E-mail tab, click New. 
The Add New E-mail Account wizard starts. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Outlook Components 

The Outlook program window includes six areas or elements in which you work with Outlook or with your Outlook 
items (e-mail messages, contact records, calendar entries, tasks, or notes). 
 
You might find that this is an ideal arrangement for the way you work. But if you're viewing the program window on 
a low-resolution screen, don't need all the available tools, or would like more space for the main work area, you 
can easily change the appearance and layout of the workspace in the following ways: 
 

1. Menu bar. When working in the Outlook program window, you can access commands from the menus 
displayed here. You can't hide the menu bar, but you can move it, docking it on any side of the program 
window or floating it anywhere on your screen. 

2. Toolbars. The buttons on the Standard toolbar, which is shown by default, represent frequently used 
commands in the File, Edit, and Actions categories. You can also display the advanced toolbar and the Web 
toolbar. To display or hide a toolbar, right-click anywhere on the menu bar or toolbar area, and then click 
the name of the toolbar. 

3. Navigation Pane. This view pane appears on the left side of the Outlook window. Its contents change 
depending on the module you're viewing-it might display the module organizational structure, view options, 
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links to external content or Help topics, and so on. You can tailor the Navigation Pane to suit your 
preferences: 

o You can minimize or expand the Navigation Pane by clicking the left- or right-facing chevrons at 
the top of the pane. 

o You can change the width of the Navigation Pane by dragging the vertical frame divider to its right. 
o You can change the number and size of the module buttons.  
o To display more buttons at the bottom of the Navigation Pane, drag the handle above the module 

buttons to increase the available space, or click the Configure Buttons button in the lower-right 
corner of the Navigation Pane, and then click Show More Buttons. To display buttons in a small 
format or allocate more space to the Navigation Pane folders and options, drag the handle to 
decrease the available space, or click the Configure Buttons button and then click Show Fewer 
Buttons. 

4. Module content pane. This view pane appears in the center of the window, and displays the content of the 
selected module-your e-mail messages, calendar, contacts, and so on. You can display and organize 
content in this pane in many ways. These options are covered in this book as part of the individual module 
discussions. 

5. Reading Pane. When displayed, you can preview a selected message, appointment, attached document, 
and so on in this view pane. You can display the pane to the right of or below the content pane, or close it 
entirely. 

6. To-Do Bar. On the right side of the Outlook window, this view pane displays a monthly calendar, your 
upcoming appointments, and your task list. You can hide or display the pane, change the number of 
calendar months and appointments shown, and arrange the task list in different ways. You can change the 
size of the module content pane by minimizing or maximizing the To-Do Bar-the minimized pane bar 
displays your next appointment and the number of active and completed tasks due today. 
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When you first start Outlook, the Mail module appears and displays your Inbox. The Navigation Pane displays the 
folder structure of your mailbox (e-mail account). When connecting to any type of e-mail account, these four 
folders are visible: 
 

 Inbox. Outlook delivers new messages to this folder. 

 Drafts. Outlook stores temporary copies of in-progress messages in this folder. 

 Outbox. Outlook holds outgoing messages in this folder while establishing a connection to your mail server. 

 Sent Items. When you send a message, Outlook stores a copy of it in this folder. 

 Junk E-mail. Outlook delivers messages held by the spam filter to this folder. 

 Deleted Items. Outlook items that you delete from other folders are held in this folder, and not deleted 
permanently until you empty the folder. 

 RSS Feeds. Web site information feeds you subscribe to are available from this folder. When you first start 
Outlook, you might find information feeds recommended by Microsoft here. 

 Search Folders. These virtual folders track messages matching specific search criteria. 
 
You can display any of the modules-Mail, Calendar, Contacts, Tasks, or Notes-by clicking the corresponding button 
at the bottom of the Navigation Pane, by clicking the module name on the Go menu, or by holding down the Ctrl 
key and then pressing the function key representing the module you want to display: 
 
Module  Keyboard shortcut  
Mail  Ctrl+1 
Calendar Ctrl+2 
Contacts Ctrl+3 
Tasks  Ctrl+4 
Notes  Ctrl+5 
 

Working with Contacts 
Having immediate access to current, accurate contact information for the people you need to interact with-by e-
mail, telephone, mail, or otherwise-is important for timely and effective communication. You can easily build and 
maintain a detailed contact list, or address book, in the Microsoft Office Outlook 2010 Contacts module. From your 
address book, you can look up information, generate messages, and share contact information with other people. 
You can also keep track of your interactions with a person whose contact information is stored in Outlook. 
 
Outlook displays contact records in the Contacts module. When you create or open a contact record, it opens in a 
contact window. The contact window has its own set of commands separate from those in the Outlook program 
window. You can create, insert, and format information in a contact record by using the contact window 
commands. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The new Outlook item window interface is designed to more closely reflect the way people generally work within 
the item windows. In a contact window, the interface includes the following elements: 
 

 Commands related to managing contact records (such as creating, saving, and printing) are available from 
the menu that appears when you click the Microsoft Office Button. This menu, which we refer to 
throughout this book as the Office menu, takes the place of the File menu that appeared in previous 
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versions of Outlook in the message, appointment, contact, and other form windows. The File menu still 
appears in the standard Outlook program window. 

 Some commands are represented by buttons on the Quick Access Toolbar to the right of the Microsoft 
Office Button. By default, the contact window Quick Access Toolbar displays the Save, Undo, Redo, Print, 
Previous Item, and Next Item buttons. The Save and Print commands are available on the Office menu, but 
the other commands are not available on either the Office menu or the Ribbon; they are available only 
from the Quick Access Toolbar. You can add commands to the Quick Access Toolbar so that they are 
available regardless of which tab is currently active in the message window. 

 The title bar displays the contact's name. At the right end of the title bar are the three familiar buttons 
that have the same function in all Windows programs. You can temporarily hide the Word window by 
clicking the Minimize button, adjust the size of the window by clicking the Restore Down/Maximize button, 
and close the active document or quit Word by clicking the Close button. 

 

Saving and Updating Contact Information 
Outlook stores contact information from different sources in separate address lists: 
 

 Global Address List (GAL). If you're using Outlook to connect to a Microsoft Exchange Server account, your 
organization's contact information is stored in the GAL. The GAL might include names, job titles, e-mail 
addresses, office locations, telephone numbers, and other contact information. It can also include 
organizational information (each person's manager and direct subordinates) and group membership 
information (the distribution lists and aliases each person belongs to). The GAL is administered as part of 
Exchange Server. Outlook users can view the GAL but not change its contents. 

 Outlook Address Books. The Contacts address book automatically created by Outlook is your main address 
book. This address book does not appear in the folder structure within the Navigation Pane-you display it 
by clicking the Contacts button. You can create additional address books; for example, you might want to 
keep contact information for family and friends in an address book separate from client contact 
information, or maintain an address book for team members attached to a specific project. Each address 
book is a folder that contains contact items; in other words, a contacts folder. Contacts folders appear in 
the Navigation Pane along with other folders you create, and you can organize them in the same manner-
for example, at the same level as your Inbox or within a project folder. All contacts folders are available 
from the My Contacts list in the Navigation Pane of the Contacts module. 

 
When you send an e-mail message to a person whose contact information is stored in one of your address books, 
you can quickly address the message to that person by typing his or her name into the To, Cc, or Bcc box, or by 
clicking the adjacent button to open the Address Book window and then selecting the intended recipient's name. 
 
For each person whose information you record in an address book, you can store the following types of general 
information: 
 

 Name, company name, and job title 

 Business, home, and alternate addresses 

 Business, home, mobile, pager, and other telephone numbers 

 Business, home, and alternate fax numbers 

 Web page address (URL), instant messaging (IM) address, and up to three e-mail addresses 

 Photo or other identifying image 

 General notes, which can include text and illustrations such as photos, clip art images, SmartArt diagrams, 
charts, and shapes 

 You can also store personal and organization-specific details for each contact: 

 Professional information, including department, office location, profession, maager's name and assistant's 
name 

 Personal information, including nickname, spouse or partner's name, birthday, anniversary, and the title 
(such as Miss, Mrs., or Ms.) and suffix (such as Jr. or Sr.) to use in correspondence 

 

Creating and Sending Messages 
Regardless of the type of e-mail account you have, as long as you have an Internet connection you can send e-mail 
messages to people within your organization and around the world. You can personalize your messages by using an 
individual font style or color, and by inserting your contact information in the form of an e-mail signature or 
business card. (You can apply other formatting, such as themes and page backgrounds, but these won't always 
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appear to e-mail recipients as you intend them to, and they can make your communications appear less 
professional.) You can format the text of your message to make it more readable, by including headings, lists, or 
tables, and represent information graphically by including charts, pictures, clip art, and other types of graphics. 
You can attach files to your message and link to other information such as files or Web pages. 
 
Addressing an e-mail message is as simple as typing the intended recipient's e-mail address into the To box. If you 
want to send a message to more than one person, indicate a different level of involvement for certain recipients, 
or include certain people without other recipients knowing. 
 
As you type a name or an e-mail address into the To, Cc, or Bcc box, Outlook displays matching addresses in a list 
below the box. Select a name or e-mail address from the list and then press Tab or Enter to insert the entire name 
or address in the box. 
 
To send a Carbon Copy of a message to a person, enter his or her e-mail address in the CC box. This is commonly 
referred to as "CCing" a person. You might CC someone to provide him or her with information but indicate that you 
don't require his or her involvement in the conversation. On the Options tab, in the Fields group, click the Show 
Bcc button. Addresses entered in the Bcc box can't be seen by other message recipients. They also aren't included 
in any replies to the original message. 
 

Saving Message Drafts 
Until you save or send a message, Outlook maintains a temporary copy of it in your Drafts folder. If you close 
Outlook (or if a problem causes Outlook to close or your computer to shut down) before you send the message, the 
draft retains most or all of your work. When the first draft of a message is saved (either automatically or 
manually), a banner appears in the message header with the notation "This message has not been sent." 
 
You can save a message draft at any time by clicking the Save button on the Quick Access Toolbar in the message 
window, or by closing the message window and then clicking Yes in the Microsoft Office Outlook message box 
asking whether to keep the draft. (If you click No, Outlook deletes the draft.) To restart work on a draft message, 
display the Mail module, click the Drafts folder in the Navigation Pane, and then double-click the message you 
want to open. 

 
Attaching Files to Messages 
A convenient way to distribute a file to other people is by attaching the file to an e-mail message. The message 
recipient can save the file to his or her hard disk, open the file from the message, or if he or she is using Outlook 
2010, preview the file in the Reading Pane. If you want to send a new version of a message you've already sent, for 
example, a weekly status report, you can resend the message. Resending a message creates a new version of the 
message with none of the extra information that might be attached to a forwarded message. To resend a message: 

 
Meetings Appointments, Events, and Meetings 
You might find that your Microsoft Office Outlook Calendar runs your life-but that isn't necessarily a bad thing! 
Using the Calendar effectively can help you to stay organized, on task, and on time. You can schedule and track 
appointments, meetings, and events. Because Outlook 2010 maps your scheduled tasks to your calendar, you can 
look at your calendar in Day view or Week view to see the tasks that need to be completed that day or that week, 
and you can track your progress by marking tasks as complete when you finish them. 
 
Using the Calendar effectively can help you to stay organized, on task, and on time. You can schedule and track 
appointments, meetings, and events. Because Outlook 2010 maps your scheduled tasks to your calendar, you can 
look at your calendar in Day view or Week view to see the tasks that need to be completed that day or that week, 
and you can track your progress by marking tasks as complete when you finish them. 
 
You can record different types of information in your Outlook calendar, scheduling an appointment and an event on 
your own calendar and then scheduling a meeting with another person. You will learn methods of determining 
meeting times during which other people are available. Then you will learn about responding to, updating, and 
canceling meeting requests. 
 
We refer to the window in which you create or respond to an appointment as the appointment window, to a 
meeting as the meeting window, and to an event as the event window; collectively we refer to these windows as 
the calendar item windows. Like the contact and message windows, the calendar item windows contain their own 
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commands, arranged on the new Office Ribbon instead of on menus and toolbars. On the Standard toolbar, click 
the New Appointment button. An untitled appointment window opens. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Scheduling and Changing Appointments 
Appointments are blocks of time you schedule for only yourself (as opposed to meetings, to which you invite other 
people). If an appointment recurs at specific intervals, such as every Tuesday and Thursday, every other week or 
every month, you can set it up in your Outlook calendar as a recurring appointment; doing so creates multiple 
instances of the appointment in your calendar at the time interval you specify. Recurring appointments are linked. 
When making changes to recurring appointments, you can choose to update all occurrences or only an individual 
occurrence of the appointment. 
 
When creating an appointment, you can show your time on the calendar as Free, Tentative, Busy, or Out Of Office. 
This information is available to other people on your network, and also when you send your schedule information to 
other people in an e-mail message or share your calendar. You can include information such as driving directions or 
Web site links in the Notes field, and attach related files so that they are easily available to you at the time of the 
appointment. 

 
 
 
 
 
 
 
 
 
 
 
Events are day-long blocks of time that you schedule on your Outlook calendar-for example, a birthday, a payroll 
day, or anything else occurring on a particular day but not at a specific time. In all other respects, events are 
identical to appointments, in that you can specify a location, indicate recurrence, indicate your availability, invite 
attendees, and attach additional information to the event item. You can create an event when viewing your 
calendar in Day view, Week view, or Month view. 
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Scheduling, Updating, and Canceling Meetings 
Scheduling meetings through Outlook is significantly simpler than scheduling meetings manually, particularly when 
you are coordinating the schedules of several people. A primary difficulty when scheduling a meeting is finding a 
time that works for everyone. Outlook displays the individual and collective schedules of people within your own 
organization, and of people outside of your organization who have published their availability to the Internet. 
 
You can send a meeting invitation (referred to as a meeting request) to any person who has an e-mail account 
(even to people who don't use Outlook). You can inform non-critical attendees of the meeting by marking their 
attendance as Optional. You can invite entire groups of people by using an e-mail alias or distribution list. The 
meeting request can include text and Web links, as well as file attachments. This is a convenient way of ensuring 
that meeting attendees have specific information available to them. Outlook automatically tracks responses from 
attendees and those responsible for scheduling the resources you requested, so you always have an up-to-date 
report of how many people will be attending your meeting. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
The calendar on the right side of the window indicates the collective availability of the group by color. Dates that 
occur in the past and non-working days are shaded; scheduling suggestions are not provided for those days. 
 

 Days when all attendees are available are white (Good) 

 Days when most attendees are available are light blue (Fair) 

 Days when most attendees are not available are medium blue (Poor) 
 
In the Suggested Times list; Outlook displays attendee availability for appointments of the length specified in the 
Duration list. The availability of required attendees is shown separately from that of optional attendees and 
resources. 
 
You might find it necessary to change the date, time, or location of a meeting-for example, because of a schedule 
conflict. You can change any information in a meeting request at any time, including adding or deleting invited 
attendees, or canceling the meeting. After you make changes, Outlook sends an updated meeting request to the 
invited attendees to keep them informed. If the only change you make is to the attendee list, Outlook gives you 
the option of sending an update only to the affected attendees. 

 
Tasks 
Many people keep one or more to-do lists going at all times, listing tasks to complete, things to buy, people to call, 
and so on. You might cross off tasks as you complete them, transfer unfinished tasks to other lists, create multiple 
lists for multiple purposes, or follow a specialized system designed by an efficiency expert. You probably write 
your lists on pieces of paper, even though you've undoubtedly experienced the pitfalls of that age-old system. 
 
If you use Microsoft Office Outlook on a daily basis, you might find it far easier to use its built-in task list, called 
the To-Do List. You can add tasks, assign due dates, receive reminders, and mark tasks as complete when you finish 
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them. You can even assign tasks to other people, and if those people use Outlook, you can view their progress on 
assigned tasks as they track progress milestones. 
 
These basic functions are very useful, but Outlook 2010 has taken task management one step further, by linking the 
To-Do List to the Outlook Calendar. When you view your calendar in Day or Week view, tasks with assigned due 
dates appear on the days they are due. You can schedule a specific block of time to complete a task by dragging it 
to your calendar, and when you finish the task and mark it complete, Outlook removes it from your calendar. 
Completed tasks are always available in your task list if you want to view them. 
 
But that's not all: Outlook 2007 introduces the To-Do Bar , a vertical pane on the right side of the program window, 
in which you can display your entire task list arranged in whatever order you want (by due date, by category, by 
importance, and so on) along with the Date Navigator and your upcoming appointments. You can modify the Date 
Navigator to display more or fewer of each of these items. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Managing Task Assignments 
You can assign tasks from your Outlook task list to other people within your organization (and other people can 
assign tasks to you). When you assign a task, Outlook sends a task request, similar to a meeting request, to the 
person you designated. He or she can accept or decline the task assignment by clicking the corresponding button in 
the Reading Pane or in the task window header. You can't assign tasks you have created from other Outlook items; 
you can assign only those you create as tasks. 
 
After you assign a task to someone else, ownership of the task transfers to that person, and you can no longer 
update the information in the task window. (The assignee becomes the task owner and you become the task 
originator.) If you keep a copy of the task on your task list, you can follow the progress as the assignee updates the 
task status and details, and you can communicate information about the task to the owner by sending status 
reports. Unless you choose otherwise, Outlook automatically sends you a status report on an assigned task when 
the assignee marks the task as complete. 

 
Removing Tasks from Your Task List 
When you complete a task, you can remove it from your task list by deleting it or by marking it as complete. When 
you delete a task, it moves first to the Deleted Items folder, and is permanently deleted when you empty that 
folder. No record of it remains on your task list. If you want to retain a record of your completed tasks, mark the 
task as complete by clicking the flag in the To-Do Bar Task List, clicking the flag column so that a selected check 
box appears in the Tasks pane, or changing the % complete setting to 100%. 
 
If a task has a reminder and you'd like to keep the task on your task list but stop the reminder from appearing, you 
can change or remove the reminder by right-clicking the task, clicking Add Reminder, and then selecting the 
reminder options you want. 
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Ch. 17. Microsoft Access 
Microsoft Office Access 2010 is a powerful relational database application providing hundreds of tools that allow 
you to quickly start tracking, sharing, and reporting information, even if you are new to database development. 
Users have access to a large library of professionally designed application templates; wizards that simplify the 
process of creating tables, forms, queries, and reports; and extensive local and online help resources. 
 
Microsoft Office Access 2010 is part of the 2010 Microsoft Office system, so the basic interface objects such as the 
Office menu, the Quick Access Toolbar, the Ribbon, and dialog boxes will be familiar if you have used other Office 
2007 products. However, Access has more dimensions than most of those other products or programs, so it might 
seem more complex until you become familiar with it. 
 
Access supports sharing data with other sources, including other programs in the 2010 Microsoft Office system, 
Microsoft SQL Server, Microsoft SharePoint Services, and documents in XML, HTML, XPS, and PDF formats. Advanced 
features allow you to create sophisticated executable database applications for use by employees and customers to 
gather and view data without their needing to know anything at all about database design or development. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
What is a Database? 
Whether you know it or not, you’re no stranger to databases. The address book on your computer is a database. 
The telephone directory in the desk drawer is, too. A recipe book is also a database in that recipes are categorized 
under different headings. If you ever arranged a CD collection in a certain way — in alphabetical order or by 
musical genre, for example — you created a database of CDs, one that makes finding a particular CD easier. Any 
place where information is stored in a systematic way can be considered a database. The only difference between 
a computerized database and a conventional database, such as a telephone directory, is that storing, finding, and 
manipulating data is much easier in a computerized database. Imagine how long it would take to find all the New 
York addresses in an address list with 10,000 entries. In Access, you can query a 10,000-entry database and find all 
New York addresses in a matter of seconds. For that matter, you can query to find all the addresses in a certain ZIP 
Code. You can put the list in alphabetical order by last name or in numerical order by ZIP Code. 
 
A database is the computer equivalent of an organized list of information. The power of a database is in your 
ability to organize and quickly retrieve precise information from it, and then to manipulate, share, and distribute 
or use this information in various ways. In Access, data is organized in tables comprised of columns and rows, 
called fields and records. Access is a relational database, so you can treat the multiple tables in one database as a 
single storage area and easily pull information from different tables in whatever order and format that suits you. 
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The types of objects you can work with in Access include tables, queries, forms, reports, macros, and modules. 
Tables are the core database objects and the purpose of every other database object is to interact with one or 
more tables. 
 
Every Access object has two or more views. For example, you view data in a table in Datasheet view and define 
how the data is displayed in Design view. 
 
One way to locate information in an Access database is to create and run a query. You use queries to find 
information so that you can view, change, or analyze it in various ways. You can view queries in Datasheet view or 
Design view. You can use the results of a query as the basis for other Access objects, such as a form or report. 
 
Forms make it easy for users to enter, retrieve, display and print information stored in tables. A form is essentially 
a window in which you can place controls that either give users information or accept information they enter. 
Forms can be viewed in Form view, Datasheet view, or Design view. 
 
Reports display information from your tables in a nicely formatted, easily accessible way, either on your computer 
screen or on paper. A report can include items of information from multiple tables and queries, values calculated 
from information in the database, and formatting elements such as headers, footers, titles, and headings. Reports 
can be viewed in Design view, Print Preview, and Layout Preview. 
 
Macros and modules substantially extend the capabilities of Access. Macros can be used to make routine database 
actions available as command buttons in forms, which help less experienced users work in your database. Modules 
are VBA programs. Whereas macros can automate many actions, VBA can be used to carry out tasks that are too 
complex to be handled with macros. 
 
Simple database programs, such as the Database component of Microsoft Works, can store information in only one 
table. These simple databases are often called flat file databases, or just flat databases. More complex database 
programs, such as Access, can store information in multiple related tables, thereby creating what are referred to 
as relational databases. If the information in a relational database is organized correctly, you can treat these 
multiple tables as a single storage area and pull information electronically from different tables in whatever order 
meets your needs. 
 
A table is just one of the types of objects that you can work with in Access. Other object types include queries, 
forms, reports, pages, macros, and modules. 
 
Of these entire object types, only one the table is used to store information. The rest are used to manage, 
manipulate, analyze, retrieve, display, or publish information stored in a table in other words, to make the 
information as accessible and therefore as useful as possible. 
 
For example, if you want to locate a person or a business in your city, you can do so because the information in the 
telephone book is organized in an understandable manner. If you want to get in touch with someone a little further 
away, you can go to the public library and use its collection of phone books, which probably includes one for each 
major city in the country. However, if you want to find the phone numbers of all the people in the country with 
your last name, or if you want to find the phone number of your grandmother's neighbor, these phone books won't 
do you much good because they aren't organized in a way that makes that information easy to find. 
 
When the information published in a phone book is stored in a database, it takes up far less space, it costs less to 
reproduce and distribute, and, if the database is designed correctly, the information can be retrieved in many 
ways. The real power of a database isn't in its ability to store information; it is in your ability to quickly retrieve 
exactly the information you want from the database. 
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Working in Access 
When you create or open a database, it opens in a database window. The new Access database window interface is 
designed to more closely reflect the way people generally work with a database or database object. The interface 
includes the following elements: 

 Commands related to managing databases (such as creating, saving, printing, backing up, and publishing) 
are available from the menu that appears when you click the Microsoft Office Button in the upper-left 
corner of the program window. This menu, which we refer to throughout this book as the Office menu, 
takes the place of the File menu that appeared in previous versions of Access. 

 Some commands are represented by buttons on the Quick Access Toolbar to the right of the Microsoft 
Office Button. By default, the database window Quick Access Toolbar displays the Save, Undo, and Redo 
buttons. You can add commands to the Quick Access Toolbar so that they are available regardless of which 
tab or object is currently active in the database window. 

 The title bar displays the name of the active database object (if it is maximized). At the right end of the 
title bar are the three familiar buttons that have the same function in all Windows programs. You can 
temporarily hide the Access window by clicking the Minimize button, adjust the size of the window by 
clicking the Restore Down/Maximize button, and close the active window or quit Access by clicking the 
Close button. 

 Below the title bar is the Ribbon, a new feature in many of the programs in the Office system. Commands 
are presented on the Ribbon rather than on the more-traditional menus or toolbars so that you can work 
most efficiently within the window. The Ribbon is organized into task-specific tabs, which are further 
divided into feature-specific or task-specific groups of commands. 

 The buttons in each group change size depending on the width of the program window. They might be 
large, small, or wide, and might be labeled with the button name, icon, or both. Pointing to any button 
displays the button name in a ScreenTip that sometimes also describes the button's function. 

 Some buttons have arrows, but not all arrows function the same way. If you point to a button that has an 
arrow is incorporated into the button body, clicking the button will display a list of options for you to 
choose from. If the arrow is separate from the button body, clicking the arrow will display a list of options 
and clicking the button will perform the currently selected action. 

 Related but less common commands are not represented in a group as buttons. Instead they are available 
from a dialog box, which you can display by clicking the Dialog Box Launcher at the right end of the group 
title bar. 

 
Opening an Existing Database 
When you start Access without opening a database, you see the Getting Started With Microsoft Office Access 
window. You can return to this window at any time by clicking the Microsoft Office Button and then clicking New. 
 
From this window you can open a blank database, create a new database from one of the many templates supplied 
with Access, from a template you download from the Microsoft Office Online Web site, or from a custom template 
saved on your computer or on a network share. You can also open a database you worked in recently, or navigate 
to any database on your computer and open it. 
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From the section at the bottom of the Getting Started window, you can link to the Microsoft Office Online Web 
site, where you can find information about all aspects of Office and download useful tools. 
 

Exploring Tables 
Tables are the core database objects. Their purpose is to store information. The purpose of every other database 
object is to interact in some manner with one or more tables. An Access database can contain thousands of tables, 
and the number of records each table can contain is limited more by the space available on your hard disk than by 
anything else. 
 
Every Access object has two or more views. For tables, the two most common views are Datasheet view, in which 
you can see and modify the table's data, and Design view, in which you can see and modify the table's structure. To 
open a table in Datasheet view, either double-click its name in the Navigation Pane, or right-click its name and 
then click Open. To open a table in Design view, right-click its name and then click Design View. After an object is 
open, you can switch between views by clicking one of the View icons in the lower-right corner of the program 
window, or by clicking the View arrow in the Views group on the Home tab, and then selecting a view from the list. 
If you simply click the View button Access switches between views in a manner that at times seems logical. If the 
current view is not Design view, it switches to Design view. If you click it again, the table switches to Datasheet 
view. When other database objects are active, clicking the View switches between views in a similar manner. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If two tables have one or more fields in common, you can embed the datasheet from one table in another. By using 
an embedded datasheet, called a sub datasheet, you can see the information in more than one table at the same 
time. For example, you might want to embed an Orders datasheet in a Customers table so that you can see the 
orders each customer has placed. 
 

Exploring Queries 
You can locate specific information stored in a table, or in multiple tables, by creating a query specifying the 
parameters of the information you want to find. For example, you might want to locate all your out-of-state 
customers who have purchased gloves within the last three months. You could find this information by sorting, 
filtering, and cross-referencing table data, but that would be a difficult and time-consuming task. It is far simpler 
to create a query that returns all records in the Customers table with billing addresses not in your state, whose 
customer IDs map to records that appear in the Transactions table within the past quarter and include item IDs 
that map to records in the Inventory table that are classified as gloves. That might sound complicated, but the 
process of creating a query to return the results described in this example is quite simple. 
 
Running a query (also called querying the database) displays a datasheet containing the records that fit your search 
criteria. You can use the query results as the basis for further analysis, create other Access objects (such as 
reports) from the results, or export the results to another format, such as an Excel spreadsheet or a Microsoft 
SharePoint list. 
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If you will want to locate records matching the search criteria at any time in the future, you can save the query, 
and run it again from the Queries section of the Navigation Pane. Each time you run a query, Access evaluates the 
records in the specified table (or tables) and displays the current subset of records that match the criteria you 
have defined. 
 
Don't worry if this all sounds a bit complicated at the moment. When you approach queries logically, they soon 
begin to make perfect sense. You can easily create queries by 
using the Query wizard that is available to help you structure 
the query, and if you create a query that you are likely to run 
more than once, you can save it. It then becomes part of the 
database and is displayed when you click Queries in the 
Navigation Pane. 
 
In the Navigation Pane, click Queries, the database window 
displays all the queries that have been saved as part of this 
database. 
 
Right-click the Current Product List query, and then click 
Object Properties. Access displays the properties of the Current 
Product List query, including a description of its purpose. The 
icon shown on the General tab matches the icon shown for this 
query in the Navigation Pane, and is an indication of the query's 
type. The query type is also specified in the Properties dialog 
box: this is a Select Query. 
 
Access displays the query in Design view 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Two boxes in the top part of the query window list the fields in the tables this query is designed to work with. The 
query is formed in the design grid at the bottom of the query window. Each column of the grid can refer to one 
field from one of the tables above. Notice that <> Yes (not equal to Yes) has been entered in the Criteria row for 
the Discontinued field. This query finds all the records that don't have a value of Yes in that field (in other words, 
all the records that have not been discontinued). 
 

Exploring Forms 
Access tables are solid lists of raw information. It will probably be quite simple for you to work directly with tables 
in a database you create for your own use, but might be overwhelming for people who don't know much about 
databases. To make it easier to enter, retrieve, display, and print information, you can design forms through which 
people can interact with your database. 
 
A form is essentially a window containing controls that either display information to people or accept information 
that people enter. Access provides a collection of standard Windows controls, such as labels, text boxes, option 
buttons, and check boxes. With a little ingenuity, you can create forms that look and work much like the dialog 
boxes in all Windows applications. 
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A form acts as a friendly interface for a table. Through a form, you can display and edit the records of the 
underlying table, or create new records. As with tables and queries, you can display forms in several views. The 
three most common views are: 
 

 Form view, in which you enter data 

 Datasheet view, which looks essentially like a table 

 Design view, in which you work with the elements of the form to refine the way it looks and works 
 
Most forms link to only one table, but if you want to link to multiple tables from one form, you can embed other 
forms (subforms) within a form (then referred to as the main form). The form shown above in Design view includes 
label controls containing text that appears in the form in Form view, and text box controls that will contain data 
from the underlying table. Although you can create a form from scratch in Design view, you will probably use this 
view most often to refine forms 
you create by using a wizard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the Navigation Pane, under Forms, double-click Orders. The Orders form opens. This form consists of a main 
form and a subform. The main form displays information from the Orders table. The subform, which looks like a 
datasheet in the middle of the main form, displays the information from the Order Details table for the current 
record. 
 
In the form window, on the record navigation bar, click the Next Record button a few times to display the next few 
records. Notice that the subform changes with each click to display the items purchased on that order. 
 
In the Navigation Pane, under Forms, double-click Products. The Products form opens in Form view. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
On the Home tab, in the Views group, click the View arrow, and then in the list, click Design View. This is the view 
in which you can add controls to a form. 



Oracas Certified Computer Expert - Part 2 - Office Applications        Oracas (Pvt.) Limited 

- 71 - 

Note that two Form Design Tools contextual tabs, Design and Arrange, were added to the Ribbon when you 
switched to Design view. Switch to Form view and then back to Design view to see this happen. Contextual tabs are 
available only when you are working on an object that needs the tools on it. 

 
 
 
 
 
 
 

On the Design contextual tab, point to each of the buttons in the center section of the Controls group to display 
the name of the control in a ScreenTip. You can use these controls to assemble custom forms for your database. 
 

Exploring Reports 
You can display the information recorded in your tables in nicely formatted, easily accessible reports, either on 
your computer screen or on paper. A report can include items of information selected from multiple tables and 
queries, values calculated from information in the database, and formatting elements such as headers, footers, 
titles, and headings. 
 
You can look at reports in four views: 

 Design View, in which you can manipulate the design of a report in the same way that you manipulate a 
form. 

 Report View, where you can scroll through the information in the report without the page breaks inserted 
when it is printed. 

 Print Preview, in which you see your report exactly as it will look when printed. 

 Layout View, which displays the data in the report (similar to Print Preview) but enables you to edit the 
layout. 

 
1. In the Navigation Pane, under Reports, right-click Customer Labels, and then click Print Preview, the 

Customer Labels report opens. 
2. Click the preview document to display a larger view of it. If the report is too small to read in Print Preview, 

you can adjust the zoom level by clicking the Zoom In button or dragging the Zoom slider that appears in 
the lower-right corner of the Print Preview window.  

 
This report prints customer names and addresses in a mailing label format. You are looking at it in a view that is 
much like Print Preview in other Office programs. 
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3. In the Navigation Pane, right-click the Sales by Category report, and then click Print Preview. 
4. Scroll through a few pages of the multi-page report by clicking the navigation buttons at the bottom of the 

window. 
5. On the View toolbar, click the Design View button. 

 
Access displays the report in Design view. In this view, the report looks similar to a form. The techniques you use 
to create forms can also be used to create reports. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Exploring Other Access Objects 
Tables, queries, forms, and reports are the objects you will use most frequently in Access. You can use them to 
create powerful and useful databases. However, you can also use macros and modules to substantially extend the 
capabilities of Access. 
 
Previous versions of Access included Data Access Pages. Access 2007 doesn't include these objects. If you are 
familiar with Data Access Pages and need something like this, you can deploy your database to a collaboration site 
built with Microsoft SharePoint products and technologies, and use the tools provided there. 
 

Macros 
A macro is a simple program that performs multiple actions. You can use a macro to have Access respond to an 
event such as the click of a button, the opening of a form, or the updating of a record. Macros can be particularly 
useful when you expect that other people who are less experienced with Access than you will work in your 
database. For example, you can make routine database actions, such as opening and closing forms or printing 
reports, available as command buttons on switchboards. And by grouping together an assortment of menu 
commands and having users carry them out with the click of a button, you can ensure that everyone does things 
the same way. 
 

Modules 
More powerful than macros, modules are Microsoft Visual Basic for Applications (VBA) programs. VBA is a high-level 
programming language developed by Microsoft for the purpose of creating Windows programs. A common set of VBA 
instructions can be used with all programs in the Microsoft Office system, and each program has its own set as 
well. Whereas macros can automate four to five dozen actions, VBA includes hundreds of commands and can be 
extended indefinitely with third-party add-ins. You could use VBA to carry out tasks that are too complex to be 
handled with macros, such as opening an Excel spreadsheet and retrieving specific information. 
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Previewing and Printing Access Objects 
Because Access is a Windows application, it interacts with your printer through standard Windows dialog boxes and 
drivers. This means that any printer that you can use from other programs can be used from Access, and any 
special features of that printer, such as color printing or duplex printing, are available in Access. 
 
You can use different Access objects tables, forms, reports, and so onto display the information stored in your 
database. Within each object there are several views available: Design view, Datasheet view, and so on. You can 
choose the view you want by selecting it from the View group on the Home tab (the views available will depend on 
the object that is active) or by clicking the buttons on the View toolbar at the right end of the status bar at the 
bottom of the window. 
 
The print-related commands are available from the Microsoft Office Button or on the Ribbon when their use would 
be appropriate, which is determined by the object displayed and the current view of that object. 
 

1. In the Navigation Pane, expand the Tables list, and then double-click the Employees table to open it in 
Datasheet view. 

 
 
 
 
 
 
 
 
 
 
This table contains information about nine employees. You can see that there are more fields than will fit on the 
screen. 

2. To display the first page of the datasheet printout, click the Microsoft Office Button, point to Print, and 
then click Print Preview. 

 

Creating a Database 
A few years ago, creating a database structure involved first analyzing your needs and then laying out the database 
design on paper. You would decide what information you needed to track and how to store it in the database. 
Creating the database structure could be a lot of work, and after you created it and entered data, making changes 
could be difficult. Templates have changed this process. Committing yourself to a particular database structure is 
no longer the big decision it once was. By using pre-packaged templates, you can create a dozen database 
applications in less time than it used to take to sketch the design of one on paper. Access templates might not 
create exactly the database application you want, but they can quickly create something very close that you can 
tweak to fit your needs. 
 
The database had all the tables, forms, reports, and code needed to import, store, and use basic information about 
people. But suppose you need to store different types of information for different types of contacts. For example, 
you might want to maintain different types of information about employees, customers, and suppliers. In addition 
to the standard information such as names, addresses, and phone numbers you might want to track these other 
kinds of information: 
 

 Employee Social Security numbers, dates of hire, marital status, deductions, and pay rates 

 Customer orders and account status 

 Supplier contacts, current order status, and discounts 
 
You could start with the template, add a lot of extra fields to the Contacts table, and then fill in just the ones you 
want for each contact type; but cramming all this information into one table would soon get pretty messy. In this 
instance, it's better to manually create a database that includes one table for each contact type: employee, 
customer, and supplier. 
 
With most computer programs, it is important to save your work frequently to avoid losing it if your computer 
crashes or the power goes out. With Access, it is not only not important to save your data, it is not possible to 
manually save it. When you move the insertion point out of a record after entering or editing information, Access 
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saves that record. This means that you don't have to worry about losing your changes, but you do have to 
remember that most data entry changes you make are permanent and can be undone only by editing the record 
again. 
 
Note, however, that changes to properties and layout are not saved automatically. If you create a new table, form, 
or report, or modify the properties or layout of an existing one, you will be prompted to save the changes before 
closing the object or the database. 
 

1. On the Getting Started with Microsoft Access page, under New Blank Database, click Blank Database. 
Access displays information about the selected template on the right side of the program window. 

2. Click Create to create the blank database in the specified location. The database opens, displaying a new 
blank table named Table1, in a group named Table1. 

 
Notice that the first column is titled ID and the second is titled Add New Field. Access automatically creates the ID 
field you can delete it if you don't need it. The ability to add fields to a table by simply typing data in the first row 
is new with Access 2007. As you enter information in the cells, Access adds fields to the table and guesses at the 
data type and other properties. 
 
At press time, there was an unresolved bug in the process for adding the first record to a table. The result of the 
bug is that if you don't save the first record after adding the first field, and before adding the second field, then 
Access increments the record ID value for each field you add to the first record. If you add seven fields, Access 
assigns the value "7" to the ID field of the first record. To avoid this bug, simply click the record selector after 
adding a value to the first field of the first record in the table. This will save the record and Access will assign a 
value of "1" to the ID field. Then continue adding the rest of your fields. 
 
Access automatically assigns the value "1" to the ID field, assigns the name "Field1" to the first column, and moves 
the Add New Field heading to the third column. The Unsaved Record icon (two dots followed by a pencil) in the 
Record Selector box at the left of the record indicates that this record has not yet been saved. 
 
On the View toolbar in the lower-right corner of the program window, click the Design View button to switch to 
Design view. In Design view, the top portion of the window contains a list of the table's fields. The Field Name 
column contains the names you specified when you created the table. The Data Type column specifies the type of 
data that the field can contain. The Description column can contain a description of the field. 
 
If you no longer want the table to have a primary key, select the field designated as the primary key in the top 
portion of the window, and on the Design tab, click Primary Key. If you want to assign a different field as the 
primary key, select that field, and click Primary Key on the Design tab to make it the primary key and move the 
icon to that field. 
 

Importing Information from another Access Database 
Suppose you already have an Access database that includes tables of information about products and orders, and 
another that includes contact information, but you want to have just one database containing all the information 
you use on a regular basis. You can save time by importing the product and order information into the contacts 
database, rather than re-creating it all. 
 
You can easily import any of the standard Access objects: tables, queries, forms, reports, pages, macros, and 
modules. When importing a table, you have the option of importing only the table definition, or both the definition 
and the data. When importing a query, you can import it as a query or you can import the results of the query as a 
table. 
 
When you import an Access object, the entire object is imported as an object of the same name in the active 
database. You don't have the option of importing selected fields or records. If the active database already has an 
object of the same name, Access imports the new object with a number appended to the end of its name. 
 
On the External Data tab, in the Import group, click the Access button. The Get External Data wizard starts. The 
pages of the wizard are specific to the import operation you selected in this case, Access Database appears in the 
title bar. 
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Importing Information from an Excel Worksheet 
Access works well with Microsoft Office Excel. You can import entire worksheets or a named range from a 
worksheet into either a new table or an existing table. You can also import specific fields from a worksheet or 
range. 
 
Excel is a good intermediate format to use when importing information that isn't set up to import directly into 
Access. For example, if you want to add or remove fields, combine or split fields, or use complex mathematical 
functions to manipulate data before importing it into Access, Excel is a great place to do it. 
 
On the External Data tab, in the Import group, click the Excel button. 
 

Exporting Information to another Access Database 
It is very simple to export any single object from one Access 2007 database to either another Access 2007 database 
or to an Access 2003 database. You can't, however, export multiple objects in one operation. Data types that are 
new in Access 2007, such as Attachment or Rich Text, will not export properly to Access 2003. Rich text is exported 
as tagged HTML, and attachments are exported as the filename of the attachment. 
 
In the Navigation Pane, under Tables, click Suppliers. Because you will export the entire table, there is no need to 
open it first. You only need to select it in the Navigation Pane. On the External Data tab, in the Export group, click 
the More button, and then in the list, click Access Database. 
 

Data Entry by Using Forms 
A database that contains the day-to-day records of an active company is useful only if it is kept current and if the 
information stored in it can be found quickly. Although Microsoft Office Access 2007 is fairly easy to use, entering, 
editing, and retrieving information in Datasheet view is not a task you would want to assign to someone who's not 
familiar with Access. Not only would these tasks be boring and inefficient, but working in Datasheet view leaves far 
too much room for error, especially if details of complex transactions have to be entered into several related 
tables. The solution to this problem, and the first step in the conversion of this database to a database application 
in which you can efficiently manage information, is to create and use forms. 
 
A form is an organized and formatted view of some or all of the fields from one or more tables or queries. Forms 
work interactively with the tables in a database. You use controls in the form to enter new information, to edit or 
remove existing information, or to locate information. Like printed forms, Access forms can include label controls 
that tell users what type of information they are expected to enter, as well as text box controls in which they can 
view or enter information. Unlike printed forms, Access forms can also include a variety of other controls, such as 
option buttons and command buttons that transform Access forms into something very much like a Microsoft 
Windows dialog box or wizard page. 
 
Before you begin creating a form, you need to know which database query or table to base it on, and have an idea 
of how the form will be used. After making these decisions, you can create a form in many ways. Remember that 
like almost any other object in Access, after you create the form, you can customize it in Design view if it does not 
quite meet your needs. 
 
The quickest way is to select a table or query in the Navigation Pane, and then click the Form button in the Forms 
group on the Create tab. This creates a simple form using all the fields in the table or query, and opens it in Layout 
view. 
 
If there is one (and only one) other table in the database that has a one-to-many relationship with the table on 
which your form is based, then the Form tool adds a datasheet (called a sub form) which displays all the records in 
the related table that pertain to the current record in the main form. 
 
On the Create tab, in the Forms group, click the Form button. 

 
Creating a Report 
You can divide the content of an Access report into two general categories: information derived from records in 
one or more tables, and everything else. Everything else category includes the title, page headers and footers, 
introductory and explanatory text, logo, background and graphics, and calculations based on the database content. 
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You can create a basic report by using the Report wizard, which provides a simple layout, attaches styles, and adds 
a text box control and its associated label for each field you specify. If the basic report doesn't fit your needs, you 
can refine it in Design view. 
 
When you include more than one table in a report, the wizard evaluates the relationships between the tables, and 
offers to group the records in any logical manner available. You can group the information in a report based on the 
data in one or more fields. You can, for example, group products by category. When you do this the wizard first 
sorts the table based on the category, then sorts the products in each category. It then creates a group header 
each time the category changes. It can also add footer to each group, in which it summarizes the information in 
the group. 
 
On the Create tab, in the Reports group, click the Report Wizard button. 

 
Previewing and Printing a Report 
Print Preview in Access is very similar to Print Preview in other Microsoft Office System products. If you look at 
your reports carefully in Print Preview, you won't be in for any major surprises when you print them. But Access 
also provides a preview option called Layout Preview that displays real data and allows you to refine the layout. 
 
On the Home tab, in the Views group, click the View arrow to display the list of views. 
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Ch. 18. The Internet 
The Internet is the largest computer network in the world. It consists of millions of computers all over the planet, 
all connected to each another. The Internet was born in the 1960s when the United States military worried that a 
nuclear bomb could destroy its computer systems (there weren’t many of them back then). So it placed several 
computers far apart from each other and connected them with some super-fast telephone lines so that the 
computers could talk to each other. If a nuclear bomb blew up one computer, another computer could instantly 
take over; thus, the computer network wouldn’t go down. Years passed and other organizations, such as colleges 
and universities, started connecting their computers to this growing network to share information. Although the 
Internet has been around a long time, it wasn’t until the 1990s that the World Wide Web was born. The World Wide 
Web is what you probably think of when you think of the Internet, although it’s really just a part of the Internet. 
The Web consists of millions of documents that are stored on hundreds of thousands of computers that are always 
connected to the Internet. These documents are called Web pages, and you can find Web pages on every subject 
imaginable—from your local newspaper to online catalogs to airline schedules, and much more. Web pages are 
stored on Web servers. A Web server is a computer, not unlike your own computer, only bigger and faster. There 
are hundreds of thousands of Web servers located all over the world. Web servers are always connected to the 
Internet so that people can view their Web pages 24 hours a day. 

 
These are exciting times for the Internet. Peer-to-peer file sharing, news, and other advances in technology have 
inspired a new generation of Web sites and services. Never before have this many Web sites and services been 
available on the Internet. It’s a lot of fun, or it’s innovative and therefore worth checking out. The focus is on 
doing things — researching, online banking, communicating, making new friends, playing games, talking over the 
Internet telephone, online shopping, online selling, and blogging. In the course of describing these and other 
activities — everyday activities that can be part of your Internet range — I introduce you to the Internet’s best Web 
sites and services.  
 
So what is the Internet? Here are some activities you can do on the Internet:  

 Browsing 

 Research 

 E-mail 

 Instant Messages  

 Blog 

 Social Networking 

 Online Shopping   

 

1. World Wide Web 
The early Internet was strictly for academics and researchers. To retrieve documents, you had to know advanced 
programming commands. You had to remember arcane numerical Internet addresses. Each host computer had a 
different command set for accessing files. 
 
Starting in the late 1980s, however, innovations in computer science made the Internet available to everyone. In 
1989, a protocol called http, or hypertext transfer protocol, made it easy to transfer files over the Internet. In 
computer terminology, a protocol is set of rules by which computers communicate with one another. You no longer 
had to learn a different set of commands to transfer a file from a host computer to your computer because each 
host computer stuck to the http standard. The letters http at the start of Web addresses refer to the hypertext 
transfer protocol. 
 
The late 1980s also saw the invention of the World Wide Web, also known simply as ―the Web.‖ The letters www in 
Web addresses stand for World Wide Web (refer to Figure 1-2). The man who coined this term, a computer scientist 
named Tim Berners-Lee, called the Web ―the universe of network accessible information, an embodiment of human 
knowledge.‖ Berners-Lee was one of those utopians I mention at the start of this chapter. In prosaic terms, the 
World Wide Web is just the sum of all the files — the Web pages, audio files, movie files, and computer programs — 
that you can bring into your computer from the Internet by way of the hypertext transfer protocol.  
 

Web Addresses 
Besides inventing the term World Wide Web, Tim Berners-Lee invented the addressing system for locating files on 
the Web. Previous to this system, you had to enter a hard-to-remember IP address number to visit a Web site, but 
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the system replaced numbers with descriptive domain names. In the system, file addresses are designated by a 
domain name and then by a folder name within the domain. 
 
http://www.oracas.com/download/software.html 
A computer reads this address like so: 
 

 http://: The file at this address can be transferred using the hypertext transfer protocol. 

 www: The file is located on the World Wide Web. 

 oracas.com: The domain name of the Web site to connect to is oracas.com. The next section in this 
chapter explains what domain names are and how computers use them to locate computers on the 
Internet. The .com ending on the domain name tells you that the site is commercial (for-profit) in nature. 

 /download: Within the oracas.com Web site, the file is found in a folder called Pages. Files on Web sites 
are stored in folders, just as files are stored in folders on your computer. 

 /software.html: The file to be transferred is called software.html. The .html file extension means that the 
file is written in hypertext markup language. 

 
The addressing convention that Tim Berners-Lee invented made it possible for computers to quickly locate and 
download files from the World Wide Web. His addressing convention also made the Web more web like. Now that 
everyone agreed on how to address Web pages, linking Web pages became much easier. Hyperlinks began 
appearing on Web pages. For the first time, you could point to and click a hyperlink on one Web page and go 
straight to another page. (By the way, Berners-Lee called Web addresses uniform resource locators, or URLs, a 
term that is thankfully falling out of favor. I only mention URLs here in case someone mentions them to you and 
you want to nod your head wisely because you know what URLs are. In this book, I refer to URLs as Web addresses.) 
 
A Web browser is a software program for exploring the Internet. Popular browsers include Internet Explorer and 
Mozilla. If your computer runs Windows, the Internet Explorer browser is already loaded on your computer. 
 
A broadband connection is an Internet connection that is always on and is capable of transmitting data very 
quickly. Broadband services can be delivered over the telephone lines, by way of a private network, by way of a 
cable modem, or in a wireless network. A broadband connection is much faster than a dialup connection. If you 
plan to spend more than an hour a day on the Internet and do sophisticated stuff like play video games online or 
download music, you owe it to yourself to spend the extra money for a broadband connection. 
 
 

Filtering Software Programs 
Program Web Address Notes Price 
Content Protect www.contentwatch.com 
Cyber Patrol www.cyberpatrol.com  
Cybersitter www.cybersitter.com  
iProtectYou www.softforyou.com  
Net Nanny www.netnanny.com  
NetFilter Home www.enologic.com  
 

2. Bookmarking Your Favorite Web Pages 
In Internet terminology, to bookmark means to save a Web address so that you can return to it later. Browsers 
offer special commands for saving Web addresses. After you have bookmarked a Web page, you need only click its 
address to visit it. Don’t be shy about bookmarking a page — you can always delete the bookmark later. Read on to 
find out how to go to bookmarked pages, how to bookmark pages, and how to manage your bookmarks. 
 

Backing up your bookmarks 

Backing up means to make a second copy of computer data, it would be a sad day if your computer crashed and 
you lost all your bookmarks. 

http://www.contentwatch.com/
http://www.cyberpatrol.com/
http://www.cybersitter.com/
http://www.softforyou.com/
http://www.netnanny.com/
http://www.enologic.com/
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Internet Explorer: Bookmarks are located at C:\Documents and Settings\Your Name\Favorites  
Mozilla: C:\Documents and Settings\Your Name\Application Data\Mozilla\Profiles\Your Profile Name\ [random 
string].slt. Salted folder, indeed! 
 

Social Bookmarking or Sharing 
When you bookmark a Web page, it means you like it well enough to want to return to it someday. Only the best 
Web pages get bookmarked. If you knew which pages others have bookmarked, you could get a head start in finding 
useful Web pages. And if you could narrow a search of the Web to bookmarked Web pages, your search would be 
more rewarding. 
 
On the idea that the only good Web page is a bookmarked Web page, the past couple of years have seen an 
innovation called social bookmarking. Social bookmarking means to share bookmarks with others. Web pages that 
you bookmark are entered on a master list of bookmarks. Others enter their bookmarked pages on the list as well. 
The result is a database of bookmarked Web pages that you can search. Most social-bookmarking services also give 
you the opportunity to store your bookmarks online and organize them in different ways. Here are the most highly 
regarded social-bookmarking Web sites: 

 Backflip (www.backflip.com) 

 del.icio.us (http://del.icio.us) 

 furl (www.furl.net) 

 Spurl.net (www.spurl.net) 
 

3. Internet Searching 
A search engine is a tool for finding information on the Internet. To use a search engine, you go to the search 
engine’s Web site and search by category, or you enter keywords to describe what you’re searching for. The results 
of your search appear on results. For each Web page found, you can read a snippet of text with a keyword you used 
in your search. You can also see the domain names of the Web pages. By studying the text and domain names, you 
can usually tell whether a Web site is worth visiting. Click a hyperlink on the search results page to visit a Web 
page. 
 
Google : www.google.com 
Yahoo : www.yahoo.com 
MSN/Bing : www.msn.com OR www.bing.com 
Ask Jeeves : www.ask.com 
AltaVista  : www.altavista.com 
All the Web : www.alltheweb.com 
Lycos : www.lycos.com 
 

Name Google Yahoo MSN/BING Ask Jeeves Lycos Alta Vista All the Web 

Domain   ✓ ✓ ✓ ✓ ✓ ✓ ✓ 
Date ✓ ✓  ✓ ✓ ✓ ✓ 
Language   ✓ ✓ ✓  ✓  ✓ 
Page Title   ✓ ✓ ✓ ✓ ✓   

Web Address ✓ ✓  ✓ ✓ ✓  

File Type  ✓ ✓ ✓   ✓ ✓ 
Region   ✓ ✓ ✓    

Links ✓       

Similar Page  ✓       

Proximity      ✓  

 



Oracas Certified Computer Expert - Part 2 - Office Applications        Oracas (Pvt.) Limited 

- 80 - 

4. E-Mail 
Electronic mail, or e-mail, is without a doubt the most popular Internet service, even though it’s one of the oldest. 
Although e-mail doesn’t have the flash and sparkle of the World Wide Web, more people use it. Every system on 
the Net supports some sort of mail service, which means that no matter what kind of computer you’re using, if it’s 
on the Internet, you can send and receive mail. Even some systems that aren’t technically on the Internet — think 
mobile phone — can do e-mail. Regardless of which type of mail you’re using, the basic tasks of reading, sending, 
addressing, and filing mail work in much the same way, so skimming this chapter is worthwhile even if you’re not 
using any of the mail programs we describe here. 
 
E-mail addresses have two parts, separated by an @ (the at-sign). The part before the @ is the username or 
mailbox, which is, roughly speaking, your personal name. The part after that is the domain, whenever you set up a 
mail program. 
 

 E-mail address : Your username followed by @ and the domain name. 

 E-mail password : The password for your e-mail mailbox. 

 Incoming POP/IMAP mail server : Server name that receives your e-mail messages. 

 Outgoing SMTP mail server : Server name that distributes your outgoing mail. 
 

Web-Based E-Mail Services 

You could do worse than having an e-mail account with Yahoo! Mail. For one thing, the account is free. It doesn’t 
cost you a red cent. And Yahoo! Mail is superior to many conventional e-mail programs when it comes to sending, 
receiving, and managing e-mail messages. 
 
Yahoo  : www.yahoomail.com  OR mail.yahoo.com 
Hotmail  : www.hotmail.com 
Gmail  : www.gmail.com  OR gmail.google.com 
 
Here are some questions to ponder in your quest for the perfect Web-based e-mail service: 
 

 Mailbox storage capacity: How many megabytes’ worth of files and e-mail messages can pile up in my e-
mail account before the service starts deleting them automatically? Mailbox storage capacity is an issue if 
others frequently send you video files, sound files, and other large files. 

 Attachment capacity: How large can the files I send or receive be? Most services don’t permit you to 
receive or send files larger than a certain amount of megabytes. 

 Unused account policy: Under what conditions are accounts deactivated automatically? Hotmail deactivates 
an account if it goes unused for more than a month and Yahoo! Mail deactivates unused accounts after four 
months. 

 
In browser, go to www.yahoomail.com. You are asked to enter your Yahoo! ID and password, after which you see 
the Yahoo! Mailbox. 
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5. Instant Messaging 
Internet e-mail is pretty fast, usually arriving in less than a minute. But sometimes that’s just not fast enough. 
Instant-message (IM) systems let you pop up a message on a friend’s screen in a matter of seconds. You can also 
tell your instant-message program the usernames of your friends and colleagues so that the program can alert you 
the instant that one of your buddies comes online and you can instantiate an instant message to them. 
 
Yahoo! Messenger : http://messenger.yahoo.com 
MSN / Windows Live Messenger  : http://messenger.msn.com 
 

Abbreviations and Smiley(s) in Instant Messaging 

Typing is way slower than talking, so when people using IM, they tend to abbreviate wildly. Many chat 
abbreviations are the same as those used in e-mail. Because IM is live, however, some are unique. We also list 
some common emoticons (sometimes called smileys) — funky combinations of punctuation used to depict the 
emotional inflection of the sender. If at first you don’t see what they are, try tilting your head to the left. 
 
Abbreviation  Means    Abbreviation  Means 
AFK    Away from keyboard   BBL    Be back later 
A/S/L    Age/sex/location   WTG    Way to go! 
BRB    Be right back    WB    Welcome back 
FTF or F2F   Face to face   IM    Instant message 
LTNS    Long time no see  LOL    Laughing out loud 
NP    No problem   :) or :-)   A smile 
;)    A wink    :( or :-(   Frown 
:’(    Crying    }:>    Devil 
 

Yahoo Messenger 
Yahoo!, the popular Web site, has its own instant-message program, named Yahoo! Messenger. It pioneered multi 
person voice and video chats back in 2001. We’ve held six-person voice-and-video conference calls using Yahoo! 
Messenger for a total cost of $0. Yahoo Messenger can communicate with Windows Live Messenger, so there’s no 
reason to install both programs, and it also has a photo-sharing feature. Yahoo! Messenger can make and receive 
voice calls to real telephones, although it costs money. You can also use Yahoo! Messenger to join Yahoo! chat 
rooms. To get the program, go to messenger.yahoo.com and follow the directions to download and install the 
program. If you don’t already have a Yahoo! account, which is also used for Yahoo! Mail and other Yahoo! services, 
you have to create one before you can log in.  
 

6. Blogs 
The word blog is shorthand for Web log. A typical blog is a mixture of comments and links — to online news sources 
and often to other blogs — where topics of concern to the blogger are discussed. A good blog gathers news stories 
and commentary from sources that you would not find on your own. Like journals, blogs are updated frequently. 
They mean to keep you abreast of the latest news. You get a picture of whatever the blogger is interested in — the 
day’s politics, advances in technology, or the state of the Internet, for example. One person runs the show, but the 
links and the quotes from other writers make each blog a collaborative effort. Even visitors to a blog can get into 
the act by writing comments for all to read.   
 
Blogger  : www.blogger.com 
Live Journal  : www.livejournal.com 
 

7. Social Networking 
Social networking is the next big thing where the Internet is concerned. Social networking means to make new 
friends or meet new business associates at an online social-networking service. It doesn’t cost anything join these 
services, although some charge for extras such as e-mailing and instant messaging with other members. 
 
Facebook : www.facebook.com 
Twitter  : www.twitter.com 


